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About This Guide

Purpose
This guide provides step-by-step procedures for:
* Calibrating an Applied Biosystems 7900HT Fast Real-Time PCR System or an
Applied Biosystems 7500 Fast Real-Time PCR System to use the MeltDoctor™
HRM Dye
+ Performing HRM experiments using MeltDoctor”” HRM Reagents: Designing the
experiment, preparing the reactions, running the reactions, and reviewing the
HRM data using HRM Software for HRM genotyping, HRM mutation scanning,
and HRM methylation studies
This Getting Started Guide is designed to help you quickly learn to use MeltDoctor"™
HRM Reagents and Applied Biosystems High Resolution Melting Software.
Prerequisites

This guide assumes that you have working knowledge of the:
+  Microsoft® Windows® XP operating system
* Instrument system software for your Real-Time PCR System:
— SDS Software v2.3 or later for the 7900HT Fast System
— 7500 Software v2.0 or later for the 7500 Fast System
— SDS Software v1.4 for the 7500 Fast System
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About This Guide

Safety information

Safety information

Safety alert words

viii

MSDSs

Four safety alert words appear in Applied Biosystems user documentation at points in
the document where you need to be aware of relevant hazards. Each alert
word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular
level of observation or action, as defined below:

IMPORTANT! — Indicates information that is necessary for proper instrument
operation or accurate chemistry kit use.

CAUTION! - Indicates a potentially hazardous situation that, if not avoided,
may result in minor or moderate injury. It may also be used to alert against
unsafe practices.

ﬁ WARNING! - Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.

DANGER! - Indicates an imminently hazardous situation that, if not avoided,
will result in death or serious injury. This signal word is to be limited to the most
extreme situations.

Except for IMPORTANTS, each safety alert word in an Applied Biosystems document
appears with an open triangle figure that contains a hazard symbol.

The MSDSs for any chemicals supplied by Applied Biosystems or Ambion are
available to you free 24 hours a day. For instructions on obtaining MSDSs, see
“MSDSs” on page 139.

IMPORTANT! For the MSDSs of chemicals not distributed by Applied Biosystems or
Ambion contact the chemical manufacturer.

Applied Biosystems High Resolution Melting Getting Started Guide



Chapter 1

Calibrate the Instrument

You must calibrate your instrument for the MeltDoctor” HRM Dye before you can
perform high resolution melting experiments using MeltDoctor'” HRM Reagents.
Applied Biosystems recommends that you calibrate your instrument for each HRM dye
that you are using or for each significant change in master mix composition.

This chapter describes how to calibrate an Applied Biosystems 7900HT Fast
Real-Time PCR System or an Applied Biosystems 7500 Fast Real-Time PCR System
for the MeltDoctor’" HRM Dye.

Note: If you use a different HRM dye, follow the calibration workflow in this chapter,
but substitute the MeltDoctor’” HRM Dye with your HRM dye of choice. For
component volumes to prepare the calibration plate, refer to the manufacturer’s
instructions.

This chapter contains instructions for calibrating the following Applied Biosystems
Real-Time PCR Systems:

Real-Time PCR System Page
7900H Fast system with SDS Software v2.3 or later 3
7500 Fast system with 7500 Software v2.0 or later 14
7500 Fast system with SDS Software v1.4 23
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Chapter 1 Calibrate the Instrument
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Section 1.1 Calibrate a 7900HT Fast system with SDS Software v2.3 or later

Section 1.1 Calibrate a 7900HT Fast system with SDS
Software v2.3 or later

IMPORTANT! Perform the amplification run, custom dye calibration, and HRM
calibration on the same day.

Perform a background calibration

Prepare the background calibration plate (page 4)
Run the background calibration plate (page 4)

Review the background calibration results (page 5)

3

Amplify the DNA in the HRM calibration plate

Prepare the MeltDoctor™ HRM Calibration Plate (page 6)

3

Run the HRM calibration plate to amplify the DNA (page 7)

Verify that the HRM calibration samples amplified (page 9)

3

Calibrate the instrument to use the MeltDoctor™ HRM Dye

Run the HRM calibration plate for the custom dye calibration (page 9)

3

Review the pure dye spectra for irregularities (page 10)

Perform a melt curve to generate the HRM calibration file

Run the HRM calibration plate for the HRM calibration (page 11)

3

Verify that the dissociation curve contains only one Tm peak (page 13)
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1 Chapter 1 Calibrate the Instrument
Perform a background calibration

Perform a background calibration

IMPORTANT! Before you can run the HRM dye calibration plate on your instrument,
you must perform a background calibration. The background calibration ensures that
the background signal is even across the reaction plate and that variation is at a
minimum,.

Required materials * Appropriate reaction plate for your reaction block:
for bigﬁg:gggg — MicroAmp® Fast Optical 384-Well Reaction Plate with Barcode, 0.1 mL OR

— MicroAmp® Fast Optical 96-Well Reaction Plate with Barcode, 0.1 mL OR
— MicroAmp® Optical 96-Well Reaction Plate with Barcode

+  MicroAmp™ Optical Adhesive Film

* Deionized water

* Pipettors and pipette tips

* Centrifuge

Prepare the 1. Add deionized water into each well of an appropriate reaction plate for your

. bac_kground reaction block:
calibration plate

Reaction plate lt%?j:}:n
Fast 384-well plate 20 yL
Fast 96-well plate 20 L
Standard 96-well plate 50 yL

2. Seal the reaction plate with optical adhesive film, then spin the plate.

Run the 1. Inthe SDS Software, create a new run file for the background calibration:
background

calibration plate " Assay: Background

» Container: Select the appropriate plate type:
— 384 Wells Clear Plate or

— 96 Wells Clear Plate

+ Template:
— Blank Template for 384-well plates and standard 96-well plates

— Fast 96 Well Background Plate.sdt for Fast 96-well plates

* (Optional) Scan or enter the barcode

Applied Biosystems High Resolution Melting Getting Started Guide



Section 1.1 Calibrate a 7900HT Fast system with SDS Software v2.3 or later 1
Perform a background calibration

2. Set the sample volume in the Instrument » Thermal Cycler » Thermal Profile
tab:

* 20 pL for Fast 384-well plates and Fast 96-well plates
* 50 pL for standard 96-well plates

3. Select the Real-Time tab, load the background calibration plate into the
instrument, then start the run.

4. At the prompt, save the background calibration file:
* Location: Create a folder called HRMCalibrationFiles.

+ File name: Use the convention:
BackgroundCalibration_<block type>_<today’s date>

5. When the Run Complete dialog box opens, click OK.

6. Save the background calibration file, then unload the background calibration
plate.

Review the 1. Select Analysis » Extract Background.
background

calibration results 2, When the software displays the following message, click OK.

[l calibration Update Complete |

\E) Background calibration information updated.

Note: If you receive a different message, refer to the Applied Biosystems 7900HT
Fast Real-Time PCR System and SDS Enterprise Database User Guide
(PN 4351684).

3. In the toolbar, click E (Hide/Show System Raw Data Pane).

Applied Biosystems High Resolution Melting Getting Started Guide 5



1 Chapter 1 Calibrate the Instrument
Amplify the DNA in the HRM calibration plate

4. Select all wells in the plate grid, then view the Raw Data Plot and verify that there

are no irregularities in the data (irregular spectral peaks).

IMPORTANT! If you find any irregularities in the data, refer to the procedures for
decontaminating the sample block in the Applied Biosystems 7900HT Fast
Real-Time PCR System and SDS Enterprise Database User Guide (PN 4351684)
The background calibration must be successful before you can perform a custom
dye calibration.

Raw Data Plot

1.00 E+3

.00 B+

6.00 B+

amplitude

4.00 B+

2.00 B+

0.00

bin

Save and close the file.

Unload the background calibration plate.

Amplify the DNA in the HRM calibration plate

Required materials .

for HRM calibration

Prepare the 1.

MeltDoctor™ HRM
Calibration Plate

Appropriate HRM calibration plate for your reaction block:

Reaction block HRM calibration plate
384-well block MeltDoctor™ HRM Calibration Plate, 384-Well
Fast 96-well block MeltDoctor™ HRM Calibration Plate, Fast 96-Well

Standard 96-well block | Prepare your own HRM calibration plate.

Note: To prepare your own HRM calibration plate using the MeltDoctor"” HRM
Master Mix and MeltDoctor™ HRM Calibration Standard, follow the procedure in
Appendix B on page 127.

Centrifuge

Remove the MeltDoctor'" HRM Calibration Plate from the freezer, then allow it to
thaw.

Spin the plate briefly.

Applied Biosystems High Resolution Melting Getting Started Guide



Section 1.1 Calibrate a 7900HT Fast system with SDS Software v2.3 or later
Amplify the DNA in the HRM calibration plate

Run the HRM 1. In the SDS Software, create a new run file for the amplification:
calibration plate to

amplify the DNA * Assay: Standard Curve (AQ)
» Container: Select the appropriate plate type:
— 384 Wells Clear Plate or
— 96 Wells Clear Plate

+ Template: Blank Template
* (Optional) Scan or enter the barcode

2. Create and add the HRM calibration detector:

a. In the Well Inspector, click Add Detector, then click New.

b. Enter HRM for the Name, select SYBR for the Reporter, then click OK.

Marme:  [HRM
Group: Pefat |
BeseriiEn |
AF Assay D |
Reporter: [SYER: —
Quencher. |Non Fluarescent =

c. In the Detector Manager, select the HRM detector, click Copy to Plate
Document, then click Done.

3. Apply the HRM detector to the wells in the plate grid:
a. Select all the wells in the plate grid.

b. In the Well Inspector, select the Use checkbox for the HRM detector.

Mame: IHRM

s Detaut -1

c. With all the wells still selected, select None from the Passive Reference
dropdown menu.

Add Detector... | ezt | Caopyto Manager |

Paszive Reference:

[ it Wiell(=)
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1 Chapter 1 Calibrate the Instrument
Amplify the DNA in the HRM calibration plate

4. Set the thermal cycler protocol in the Instrument » Thermal Cycler » Thermal
Profile tab:

* Mode: Standard
» Sample Volume (uL):
— 20 pL for Fast 384-well plates and Fast 96-well plates

— 50 puL for standard 96-well plates

* Thermal profile:

Stage Step Temp Time R':r;r;p

Holding Enzyme activation 95°C  10min = 100%
Cycling (40 cycles) Denature 95°C | 15sec = 100%
Anneal/extend 60 °C 1 min 100%

5. Select the Real-Time tab, load the HRM calibration plate into the instrument,
then start the run.

6. At the prompt, save the amplification file:

* Location: HRMCalibrationFiles folder that you created when you performed
the background calibration (see page 5).

e File name: Use the convention:
Amplification_<block type>_<today’s date>

7. When the Run Complete dialog box opens, click OK.

8. Save the amplification file, then unload the HRM calibration plate.
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Section 1.1 Calibrate a 7900HT Fast system with SDS Software v2.3 or later 1
Calibrate the instrument to use the MeltDoctor™ HRM Dye

Verify that the HRM 1. Click ™ (Analyze).
calibration samples

amplified 2. View the Amplification Plot, then review the plot for normal characteristics:

* Fluorescence levels that exceed the threshold between cycles 8 and 35
An exponential increase in fluorescence
Standard deviation of C values <0.25.

LG

mmmmmmmmmmmmmmm

Note: If the Amplification Plot looks abnormal, contact an Applied Biosystems
representative to identify and resolve the problem.

3. Save and close the file.

Calibrate the instrument to use the MeltDoctor™ HRM Dye

Perform a custom dye calibration for the MeltDoctor” HRM Dye using the same
MeltDoctor™ HRM Calibration Plate that you amplified on page 6.

Run the HRM 1. In the SDS Software, create a new run file for the custom dye calibration:
calibration plate for . )
the custom dye Assay: Pure Spectra
calibration .

Container: Select the appropriate plate type:
— 384 Wells Clear Plate or

— 96 Wells Clear Plate
+ Template: Blank Template
* (Optional) Scan or enter the barcode
2. Add the MeltDoctor™ HRM dye to the Dye Library:

a. Select Tools » Dye Manager, then click New.

Applied Biosystems High Resolution Melting Getting Started Guide
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Review the pure
dye spectra for
irregularities

N

Chapter 1 Calibrate the Instrument
Calibrate the instrument to use the MeltDoctor™ HRM Dye

b. Enter MeltDoctor for the name, then click OK.

x

Enter name of new dye
IMertDodor

Cancel |

c. Click Done to exit the Dye Manager.

Apply the MeltDoctor dye to the plate grid:
a. Select all the wells in the plate grid.
b. From the Dyes dropdown list, select MeltDoctor.

=etup | Instrumerit |

(VT et Doctor ﬂ

Select the Instrument » Thermal Cycler » Thermal Profile tabs, then set the
sample volume:

* 20 pL for Fast 384-well plates and Fast 96-well plates
* 50 pL for standard 96-well plates

Select the Real-Time tab, spin the HRM calibration plate briefly, load the plate
into the instrument, then start the run.

At the prompt, save the custom dye calibration file:

* Location: HRMCalibrationFiles folder that you created when you performed
the background calibration (see page 5).

» File name: Use the convention:
CustomDye_<block type>_<today’s date>

When the Run Complete dialog box opens, click OK.

Save the custom dye calibration file, then unload the HRM calibration plate.

. Select Analysis » Extract Pure Dye Wizard.

Follow the instructions in the Pure Dye Wizard to extract the pure dye spectra. In
each screen, inspect the spectra for shifts in peak location. When complete, the
software displays a message reporting the extraction of the pure dyes.

Note: If you find any irregularities in the data, refer to the Applied Biosystems
7900HT Fast Real-Time PCR System and SDS Enterprise Database User Guide
(PN 4351684). You cannot complete the HRM calibration until the custom dye
calibration passes.
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Section 1.1 Calibrate a 7900HT Fast system with SDS Software v2.3 or later 1
Perform a melt curve to generate the HRM calibration file

3. Save the custom dye calibration file, unload the HRM calibration plate, then spin
the plate briefly.

Perform a melt curve to generate the HRM calibration file

Use the HRM calibration plate a third time to perform a melt curve and generate an
HRM calibration file for the Applied Biosystems High Resolution Melting Software
(HRM Software).

Run the HRM 1. In the SDS Software, create a new run file for the HRM calibration:

calibration plate for . )
the HRM calibration Assay: Standard Curve (AQ)

» Container: Select the appropriate plate type:
— 384 Wells Clear Plate or

— 96 Wells Clear Plate
+ Template: Blank Template
* (Optional) Scan or enter the barcode
2. Create and add the MeltDoctor detector to the plate document:
a. In the Well Inspector, click Add Detector, then click New.

b. Enter MeltDoctor for the Name, select MeltDoctor for the Reporter, then
click OK.

Matmne: IMeItDDctur

Group  Petaul -
Asseigtan |
AF assay D |

Reporter:  |MeftDoctor |

Quencher: |Non Fluorescent =]

c. Inthe Detector Manager, select the MeltDoctor detector, click Copy to Plate
Document, then click Done.

3. Apply the MeltDoctor detector to the wells in the plate grid:
a. Select all the wells in the plate grid.

b. In the Well Inspector, select the Use checkbox for the MeltDoctor detector.

Setup I Instrument I
Wielics): &1-p24

Sample Matne: I* Mixed *

Lse Detector Reparter

WetDoctor hetDoctor Linknowvh
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1 Chapter 1 Calibrate the Instrument
Perform a melt curve to generate the HRM calibration file

c. With all the wells still selected, select None from the Passive Reference
dropdown menu.

Add Detector... | ezt | Caopyto Manager |

Paszive Reference:

[ it Wiell(=)

4. Select the Instrument » Thermal Cycler » Thermal Profile tabs, then set the
thermal cycler protocol:

* Mode: Standard
* Sample Volume (uL):
— 20 pL for Fast 384-well plates and Fast 96-well plates

— 50 uL for standard 96-well plates

» Thermal profile:

. Ramp

Stage Step Temp Time rate

Melt curve/dissociation | Denature 95 °C 10sec = 100%
Anneal 60 °C 1 min 100%

High resolution melting | 95°C | 15 sec 1%
Anneal 60°C | 15sec = 100%

5. Select the Real-Time tab, spin the HRM calibration plate briefly, load the plate
into the instrument, then start the run.

6. At the prompt, save the melt curve file:

* Location: HRMCalibrationFiles folder that you created when you performed
the background calibration (see page 5).

+ File name: Use the convention:
HRMCalibration_MeltDoctorDye_<instrument info>_<today’s date>

IMPORTANT! Make sure you include instrument information (instrument
model number, plate type, and software version) in the file name so you can
verify that the HRM calibration file and the HRM experiment file are run on
the same instrument. If you have multiple instruments, include information to
identify the instrument (for example, an instrument name).

7. When the Run Complete dialog box opens, click OK.

8. Save the HRM calibration file, then unload the HRM calibration plate.

12 Applied Biosystems High Resolution Melting Getting Started Guide



Verify that the
dissociation curve
contains only one
Tm peak

Section 1.1 Calibrate a 7900HT Fast system with SDS Software v2.3 or later

Perform a melt curve to generate the HRM calibration file

. Click ™ (Analyze).

. If you receive the following message, click OK.

@ This plate does not contain a usable PCR stage. The clipped data can not be calculated,

as in the example below.

Derivafive

o
20

Note: If the Dissociation Curve contains more than 1 Tm Peak, more than one
PCR product was produced. Contact an Applied Biosystems representative to
identify and resolve the problem.

Save and close the file, then unload the HRM dye calibration plate.

. View the Dissociation Curve, then verify that the curve contains only 1 Tm peak,

IMPORTANT! When you start the HRM software for the first time, you will be
prompted to select the default HRM calibration file. Select this file
(HRMCalibration_MeltDoctorDye_<instrumentinfo>_<today’s date>).

Applied Biosystems High Resolution Melting Getting Started Guide
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1 Chapter 1 Calibrate the Instrument
Perform a melt curve to generate the HRM calibration file

Section 1.2 Calibrate a 7500 Fast system with 7500
Software v2.0 or later

IMPORTANT! Perform the amplification run, custom dye calibration, and HRM
calibration on the same day.

Perform a background calibration

Prepare the background calibration plate (page 15)
Run the background calibration plate (page 15)

Review the background calibration results (page 16)

3

Amplify the DNA in the HRM calibration plate

Prepare the MeltDoctor™ HRM Calibration Plate (page 17)

3

Run the HRM calibration plate to amplify the DNA (page 17)

Verify that the HRM calibration samples amplified (page 18)

3

Calibrate the instrument to use the MeltDoctor™ HRM Dye

Run the HRM calibration plate for the custom dye calibration (page 19)

Review the custom dye calibration results (page 19)

3

Perform a melt curve to generate the HRM calibration file

Run the HRM calibration plate for the HRM calibration (page 20)

3

Verify that the Melt Curve contains only one Tm peak (page 21)

14 Applied Biosystems High Resolution Melting Getting Started Guide



Perform a background calibration

Section 1.2 Calibrate a 7500 Fast system with 7500 Software v2.0 or later

Perform a background calibration

IMPORTANT! Before you can run the HRM dye calibration plate on your instrument,
you must perform a background calibration. The background calibration ensures that
the background signal is even across the reaction plate and that variation is at a
minimum,.

Required materials +  MicroAmp"" Fast Optical 96-Well Reaction Plate with Barcode, 0.1 mL
for background . M ™ -
calibration MicroAmp = Optical Adhesive Film
* Deionized water
* Pipettors and pipette tips
* Centrifuge

Prepare the 1. Add 20 pL deionized water into each well of a Fast 96-well reaction plate.
background

calibration plate 2 Seal the reaction plate with optical adhesive film, then spin the plate.

Run the 1. In the 7500 Software, select Instrument » Instrument Maintenance Manager,

_background then in the navigation pane, select Background.
calibration plate

2. Click Start Calibration, then follow the instructions in the Setup screen, but use
the background calibration plate you prepared above.

3. In the Run screen, click START RUN.
When the run is complete, the Analysis screen is automatically displayed.

Applied Biosystems High Resolution Melting Getting Started Guide 15



1 Chapter 1 Calibrate the Instrument
Perform a background calibration

Review the 1. In the Analysis screen, verify that the background calibration passed.
background

calibration results Note: If the background calibration failed, refer to the procedures for cleaning the
sample block in the Applied Biosystems 7500/7500 Fast Real-Time PCR System
Maintenance Guide (PN 4387777). The background calibration must pass before
you can perform a custom dye calibration.

Analysis Data

350000

30000.0

250000

20000 0

Average Fluorescence

15000.0

10000 0

000.0

Filter

2. Finish the background calibration and close the Instrument Maintenance Manager.
The software saves the background calibration file.

3. Unload the background calibration plate.
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Section 1.2 Calibrate a 7500 Fast system with 7500 Software v2.0 or later 1
Amplify the DNA in the HRM calibration plate

Amplify the DNA in the HRM calibration plate

Required materials + MeltDoctor'™" HRM Calibration Plate, Fast 96-Well
for HRM calibration

Note: To prepare your own HRM calibration plate using the MeltDoctor”” HRM
Master Mix and MeltDoctor™ HRM Calibration Standard, follow the procedure in
Appendix B on page 127.

» Centrifuge

PrepTaMre the 1. Remove the Fast 96-Well MeltDoctor"” HRM Calibration Plate from the freezer,
MeltDoctor ® HRM then allow it to thaw.
Calibration Plate

2. Spin the plate briefly.

Run the HRM 1. In the 7500 Software, create a new experiment for the amplification:
calibration plate to

amplify the DNA * Experiment Name — Use the convention: Amplification_<today’s date>

* Instrument — 7500 Fast (96 Wells)

* Experiment type — Quantitation - Standard Curve

+ Reagents — SYBR® Green Reagents

* Ramp speed — Standard (~ 2 hours to complete a run)

2. In the Plate Setup » Define Targets and Samples tab, define the calibration target
as Target 1 for the target name and SYBR for the reporter.

Define Targets

| Add New Target Add Saved Target Save Target | Delete Target ‘ ‘

Target Name Reporter Quencher Color

[Target1 ||sver LI Mone LI I:l -

3. In the Plate Setup » Assign Targets and Samples tab, assign the Target 1 target to
the wells in the plate grid:

a. Select all the wells in the plate grid.
b. Select the Assign checkbox for Target 1, then select [ (Unknown) as the

Task.
Assign Target Task Quantity
vl Target 1 |m”|3”|]|

c. Select None as the passive reference.

Select the dye to use as the passive reference.

INone 'l
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1 Chapter 1 Calibrate the Instrument
Amplify the DNA in the HRM calibration plate

4. In the Setup » Run Method tab, set the thermal cycler conditions:
* Reaction Volume Per Well: 20 pL
» Thermal profile:

Stage Step Temp Time

Holding Enzyme activation 95°C | 10 min
Cycling (40 cycles) Denature 95°C | 15sec
Anneal/extend 60 °C 1 min

5. Load the HRM calibration plate into the instrument, then start the run.

6. At the prompt, save the amplification file:
* Location: Create a folder called HRMCalibrationFiles.
+ File name: Use the convention Amplification_<today’s date>
When the run is complete, the Analysis screen is automatically displayed.

7. Unload the HRM calibration plate.

Verify that the HRM 1. Review the Amplification Plot for normal characteristics:
callbratlonas&a];)r}i[.;ilgg » Fluorescence levels that exceed the threshold between cycles 8 and 35
* An exponential increase in fluorescence

+ Standard deviation of C values <0.25.

nnnnnnnnn

nnnnnnnn

1000000

100000

10000

1000 150,
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00001

0.00001

0000001

Note: If the Amplification Plot looks abnormal, contact an Applied Biosystems
representative to identify and resolve the problem.

2. Save and close the file.
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Section 1.2 Calibrate a 7500 Fast system with 7500 Software v2.0 or later 1
Calibrate the instrument to use the MeltDoctor™ HRM Dye

Calibrate the instrument to use the MeltDoctor™ HRM Dye

Run the HRM
calibration plate for
the custom dye
calibration

Review the custom
dye calibration
results

Perform a custom dye calibration for the MeltDoctor"” HRM Dye using the same
MeltDoctor™ HRM Calibration Plate that you amplified on page 18.

1. Inthe 7500 Software, select Instrument » Instrument Maintenance Manager,
then in the navigation pane, select Custom Dye Calibration.

2. Click Start Calibration, then follow the instructions in the Setup screen:

a.

In step 1, for the custom dye calibration plate, use the amplified
MeltDoctor™ HRM Calibration Plate.

Add the HRM dye to the Dye Library: Click New Dye, then enter
MeltDoctor for the name, select Reporter as the dye type, and click OK.

Mame: |MeItDoct0r

Wavelength (Optional): | |nm LI

Type
' Reporter

 Quencher

 Both

In step 2, select MeltDoctor as the Dye Name.

2. Select a dye or create a new dye:

Dye Mame: |MeltDoctor  + || NewDye |

. In step 3, set the temperature to 60 °C (default).

3. Set the data collection temperature:

Temperature: 60.0|°C

Spin the HRM calibration plate briefly, load the plate into the instrument,
select the checkbox The custom dye plate is loaded into the instrument,
then click Next.

3. In the Run screen, click START RUN.

4. When the run is complete, unload the HRM calibration plate, then click Next to
view the Analysis screen.

1. In the Analysis screen, verify that the custom dye calibration passed.

Note: If the custom dye calibration failed, refer to the Applied Biosystems
7500/7500 Fast Real-Time PCR System Maintenance Guide (PN 4387777). You
cannot complete the HRM calibration until the custom dye calibration passes.

2. Finish the custom dye calibration and close the Instrument Maintenance Manager.
The software saves the custom dye calibration file.
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Perform a melt curve to generate the HRM calibration file

Perform a melt curve to generate the HRM calibration file

Use the HRM calibration plate a third time to perform a melt curve and generate an
HRM calibration file for the Applied Biosystems High Resolution Melting Software
(HRM Software).

Run the HRM 1. In the 7500 Software, create a new experiment for the HRM calibration:
calibration plate for

the HRM calibration * Experiment Name — Use the convention

HRMCalibration_MeltDoctorDye_<instrument info>_<today’s date>
* Instrument — 7500 Fast (96 Wells)
» Experiment type — Melt Curve
* Reagents — Other
* Ramp speed — Fast

2. In the Plate Setup » Define Targets and Samples tab, define the calibration target
as Target 1 for the target name and MeltDoctor for the reporter.

3. In the Plate Setup » Assign Targets and Samples tab, assign Target 1 to the wells
in the plate grid:

a. Select all the wells in the plate grid.
b. Select the Assign checkbox for Target 1, then select (Unknown) as the

Task.
Assign Target Task Quantity
vl Target 1 ||||]|||]|

c. Select None as the passive reference.

Select the dye to use as the passive reference.

INone 'l

4. Set the thermal cycler protocol in the Instrument » Thermal Profile tab:
* Reaction Volume Per Well — 20 puL
» Thermal profile:

Stage Step Temp Time
Melt curve/dissociation | Denature 95°C | 10sec
Anneal 60 °C 1 min

High resolution melting | 95°C | 15 sec
Anneal 60°C | 15sec

* Click Select/View Filters, then select only Filter-1

5. Spin the HRM calibration plate briefly, load the plate into the instrument, then
start the run.
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Section 1.2 Calibrate a 7500 Fast system with 7500 Software v2.0 or later 1
Perform a melt curve to generate the HRM calibration file

6. At the prompt, save the HRM calibration file:

* Location: HRMCalibrationFiles folder that you created when you amplified
the HRM calibration plate (see page 18).

* File name: Use the convention:
HRMCalibration_MeltDoctorDye_<instrument info>_<today’s date>

IMPORTANT! Make sure you include instrument information (instrument
model number, plate type, and software version) in the file name so you can
verify that the HRM calibration file and the HRM experiment file are run on
the same instrument. If you have multiple instruments, include information to
identify the instrument (for example, an instrument name).

When the run is complete, the Analysis screen is automatically displayed.

Verify that the Melt 1. Verify that the Melt Curve contains only 1 Tm peak, as in the example below.
Curve contains only
one Tm peak I

1800000 0

13000000

Derivative Reporter (-fn)

500 50 1) 0 LT} 750

0 850
T 9260

Temperature (°C)

Note: If the Melt Curve contains more than 1 Tm Peak, more than one PCR
product was produced. Contact an Applied Biosystems representative to identify
and resolve the problem.

2. Save and close the file, then unload the HRM dye calibration plate.

IMPORTANT! When you start the HRM software for the first time, you will be
prompted to select the default HRM calibration file. Select this file
(HRMCalibration_MeltDoctorDye_<instrumentinfo>_<today’s date>).
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Perform a melt curve to generate the HRM calibration file

29 Applied Biosystems High Resolution Melting Getting Started Guide



Perform a melt curve to generate the HRM calibration file

Section 1.3 Calibrate a 7500 Fast system with SDS Software v1.4

Section 1.3 Calibrate a 7500 Fast system with SDS
Software v1.4

IMPORTANT! Perform the amplification run, custom dye calibration, and HRM
calibration on the same day.

Perform a background calibration

Prepare the background calibration plate (page 24)
Run the background calibration plate (page 24)

Review the background calibration results (page 24)

3

Amplify the DNA in the HRM calibration plate

Prepare the MeltDoctor™ HRM Calibration Plate (page 26)

3

Run the HRM calibration plate to amplify the DNA (page 26)

Verify that the HRM calibration samples amplified (page 28)

3

Calibrate the instrument to use the MeltDoctor™ HRM Dye

Run the HRM calibration plate for the custom dye calibration (page 29)

Review the pure dye spectra for irregularities (page 29)

Perform a melt curve to generate the HRM calibration file

Run the HRM calibration plate for the HRM calibration (page 31)

3

Verify that the Dissociation Curve contains only one Tm peak (page 33)
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Perform a background calibration

Perform a background calibration

IMPORTANT! Before you can run the HRM dye calibration plate on your instrument,
you must perform a background calibration. The background calibration ensures that
the background signal is even across the reaction plate and that variation is at a
minimum,.

Required materials »  MicroAmp"" Fast Optical 96-Well Reaction Plate with Barcode, 0.1 mL
for background . M ™ -
calibration MicroAmp = Optical Adhesive Film
* Deionized water
* Pipettors and pipette tips
* Centrifuge

Prepare the 1. Add 20 pL deionized water into each well of a Fast 96-well reaction plate.
background

calibration plate 2 Seal the reaction plate with optical adhesive film, then spin the plate.

Run the 1. In the SDS Software, create a new run file for the background calibration:
background

calibration plate " Assay: Background

» Container: 96-Well Clear
+ Template: Blank Document

2. Select the Instrument tab, load the calibration plate into the instrument, then start
the run.

3. At the prompt, save the background calibration file:
* Location: Create a folder called HRMCalibrationFiles.

» File name: Use the convention:
BackgroundCalibration_<today’s date>

4. When the Run completed successfully message appears, click OK.

5. Save the background calibration file, then unload the background calibration
plate.

Review the 1. Review the background calibration results:

background _
calibration results a. Click (or select Analysis » Extract Background).
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Perform a background calibration

Section 1.3 Calibrate a 7500 Fast system with SDS Software v1.4

b. When the software displays the following message, click OK.

SDS Calibration

1 ) Background Extraction Complete

Note: If you receive a different message, refer to the Applied Biosystems
7300/7500/7500 Fast Real-Time PCR System Installation and Maintenance
Guide.

c. Select the Results » Spectra tabs, then select all wells in the plate grid.

d. Inspect the raw data to verify that there are no irregularities in the data
(irregular spectral peaks).

Note: If you find any irregularities in the data, refer to the procedures for
cleaning the sample block in the Applied Biosystems 7300/7500/7500 Fast
Real-Time PCR System Installation and Maintenance Guide (PN 4347828).
The background calibration must be successful before you can perform a
custom dye calibration.

[/ Setup ¥ Instrument YResults

[Plate ¥ Spectra { Report {

Raw Data

4737e+004

4.000e+004

3.000e+004

Fluorescence

2.000e+004

1.0006+004

8.620e+002

A ] & ) 3
Filters

2. Save and close the file.

3. Unload the background calibration plate.
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Amplify the DNA in the HRM calibration plate

Amplify the DNA in the HRM calibration plate

Required materials
for HRM calibration

Prepare the
MeltDoctor™ HRM
Calibration Plate

Run the HRM
calibration plate to
amplify the DNA

26

MeltDoctor" HRM Calibration Plate, Fast 96-Well

Note: To prepare your own HRM calibration plate using the MeltDoctor”” HRM
Master Mix and MeltDoctor™ HRM Calibration Standard, follow the procedure in
Appendix B on page 127.

Centrifuge

. Remove the Fast 96-Well MeltDoctor'" HRM Calibration Plate from the freezer,

then allow it to thaw.

. Spin the plate briefly.

. In the SDS Software, create a new run file for the amplification:

* Assay: Standard Curve (Absolute Quantitation)
» Container: 96-Well Clear
» Template: Blank Document

. Create and add a detector to the plate document:

a. Click New Detector.
b. Enter HRM for the Name, select SYBR for the Reporter Dye, then click OK.

Name: [HFM
Description; |
Reparter Dye: [SYEBR =l
Quencher Dye: [fnone) =l

c. Select HRM from the table, then click Add.

d. From the Passive Reference dropdown menu, select (none), then click Next.

Find: I d j Passive Reference: lm
Detector Hame | Description | Reporter | Quencher Detectors in Document |
SYER [rone) HFiM
Add > |
<< Remove |

3. Apply the detector to the wells in the plate grid:

a. Select all the wells in the plate grid.
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Amplify the DNA in the HRM calibration plate

b. Select the Use checkbox for the HRM detector.

Use Detector Reporter Quencher Task Quantity
HREM SYER [none) Unknoven

4. Set the thermal cycler protocol in the Instrument » Thermal Profile tab:
* Thermal profile:

Stage Step Temp Time

Holding Enzyme activation 95°C | 10 min
Cycling (40 cycles) Denature 95°C | 15sec
Anneal/extend 60 °C 1 min

* Sample Volume (uL): 20
*  Run Mode: Fast 7500

5. Load the HRM calibration plate into the instrument, then start the run.

6. At the prompt, save the amplification file:

* Location: HRMCalibrationFiles folder that you created when you performed

the background calibration (see page 24).

e File name: Use the convention:
Amplification_<today’s date>

7. When the Run completed successfully message appears, click OK.

8. Save the amplification file, then unload the HRM calibration plate.
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1 Chapter 1 Calibrate the Instrument
Amplify the DNA in the HRM calibration plate

Verify that the HRM 1. Click ® (Analyze), then select the Results tab.
calibration samples

amplified 2. Review the Amplification Plot for normal characteristics:
* Fluorescence levels that exceed the threshold between cycles 8 and 35
* An exponential increase in fluorescence
» Standard deviation of C; values <0.25.

1.0002+007

EE R ——
=1 | | |

1.000e+006 ‘ ‘:*

1.0002+005

1.000e+004

1.000e+003

Detta Rn

1.000e+002

1.000e+001

1.000e+000

1.000e-001

12 3 4 5 B T 8 8 10 11 1% 13 14 15 16 17 18 18 20 21 22 23 24 35 26 27 38 29 30 31 32 33 34 35 36 37 3@ 39 40

Cvcle Number

Note: If the Amplification Plot looks abnormal, contact an Applied Biosystems
representative to identify and resolve the problem.

3. Save and close the file.
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Section 1.3 Calibrate a 7500 Fast system with SDS Software v1.4 1
Calibrate the instrument to use the MeltDoctor™ HRM Dye

Calibrate the instrument to use the MeltDoctor™ HRM Dye

Perform a custom dye calibration for the MeltDoctor” HRM Dye using the same
MeltDoctor™ HRM Calibration Plate that you amplified on page 17.

Run the HRM 1. In the SDS Software, create a new run file for the custom dye calibration:
calibration plate for
the custom dye
calibration » Container: 96-Well Clear

* Assay: Pure Spectra

+ Template: Blank Document

2. In the Pure Spectra Calibration Manager, set up the custom dye calibration:
a. Click Add Dye.
b. Enter MeltDoctor for the name, then click OK.
c. Select MeltDoctor from the dye list, then click Calibrate.

Note: If you are prompted to disconnect the plate document, click Yes.

3. Apply the MeltDoctor dye to the plate grid:
a. Select all the wells in the plate grid.

b. From the Dyes dropdown list, select MeltDoctor.

4. Spin the HRM calibration plate briefly, load the plate into the instrument, then
click Yes to start the custom dye calibration.

5. When the run is complete, click Finish. The software automatically saves the
HRM dye data to a calibration file on the computer hard drive.

6. Unload the HRM calibration plate.

Review the pure 1. Click (or select Analysis » Extract Pure Spectra).
dye spectra for

irregularities 2 When the software displays the following message, click OK.

SDS Calibration

-
\14) Pure Spectra Extraction Complete

Note: If you receive a different message, refer to Applied Biosystems
7300/7500/7500 Fast Real-Time PCR System Installation and Maintenance
Guide.

3. Select the Results » Spectra tabs, then select all wells in the plate grid.
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Calibrate the instrument to use the MeltDoctor™ HRM Dye

4. Verify that the peak of the MeltDoctor™ Dye appears in Filter A.

Note: If you find any irregularities in the data, refer to the Applied Biosystems
7300/7500/7500 Fast Real-Time PCR System Installation and Maintenance Guide
(PN 4347828). You cannot complete the HRM calibration until the custom dye
calibration passes.

Setup ¥ Instrument YResults |
[PlateYSpectra{ Component Y Amplification Plot ¥ Standard Curve Di iation Y Report |

Raw Data

494084008

4,000e+006

3.0008+008

Fluorescence

200084008

1.0008+008

0.000e+000

A B c D E

Filters

1 Cycle 0

5. Close the custom dye calibration file, then unload the HRM calibration plate.
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Perform a melt curve to generate the HRM calibration file

Section 1.3 Calibrate a 7500 Fast system with SDS Software v1.4

Perform a melt curve to generate the HRM calibration file

Use the HRM calibration plate a third time to perform a melt curve and generate an
HRM calibration file for the Applied Biosystems High Resolution Melting Software
(HRM Software).

Run the HRM 1. In the SDS Software, create a new run file for the HRM calibration:
calibration plate for . ) .
the HRM calibration Assay: Standard Curve (Absolute Quantitation)
* Container: 96-Well Clear
* Template: Blank Document

2. Create and add an HRM detector to the plate document:
a. Click New Detector.
b. Enter MeltDoctor for the Name, select MELTDOCTOR for the Reporter

Dye, then click OK.
MName: IMeItDoctor
Description: I
Reporter Dye: [MELTDOCTOR |
Quencher Dye: I[none] j

c. Select MeltDoctor from the table, then click Add.

d. From the Passive Reference dropdown menu, select (none), then click Next.

Find:l dj Passive Reference: ([yE]
Detector Hame | Description | Reporter | Quenche Detectors in Document |
MeltD octar
HRM SYBR [none)
Add > |
<< Remove |
J] | 2

3. Apply the detector to the wells in the plate grid:

a. Select all the wells in the plate grid.
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Perform a melt curve to generate the HRM calibration file

b. Select the Use checkbox for the MeltDoctor detector.

Use Detector Reporter

Quencher Task Quantity
MELTD OR { 3

Unknowwn

4. Set the thermal cycler protocol in the Instrument » Thermal Profile tab:

* Thermal profile:

Stage Step Temp Time
Melt curve/dissociation | Denature 95°C | 10sec
Anneal 60 °C 1 min

High resolution melting | 95°C | 15 sec
Anneal 60°C | 15sec

» Sample Volume (uL): 20
* Run Mode: Fast 7500
* Expert Mode: Select the checkbox, then select Filter A

5. Spin the HRM calibration plate briefly, load the plate into the instrument, then
start the run.

6. At the prompt, save the HRM calibration file:

* Location: HRMCalibrationFiles folder that you created when you performed
the background calibration (see page 24).

* File name: Use the convention:
HRMCalibration_MeltDoctorDye_<instrument info>_<today’s date>

IMPORTANT! Make sure you include instrument information (instrument
model number, plate type, and software version) in the file name so you can
verify that the HRM calibration file and the HRM experiment file are run on
the same instrument. If you have multiple instruments, include information to
identify the instrument (for example, an instrument name).

7. When the Run completed successfully message appears, click OK.

8. Save the HRM calibration file, then unload the HRM calibration plate.
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Section 1.3 Calibrate a 7500 Fast system with SDS Software v1.4

Verify that the 1. Click ® (Analyze), then select the Results tab.
Dissociation Curve

contains only one 2. verify that the Dissociation Curve contains only 1 Tm peak, as in the example
Tm peak below.

7.0008+004

6.0002+004

5.0002+004 M

4.0002+004

o 3.000e+004

5 2.000e+004

LI Lt g )
0.000+000 I ! V w VW | VW V\J 1 T V\)u

-1.000e+004 i

-2.000e+004

Note: If the Dissociation Curve contains more than 1 Tm Peak, more than one
PCR product was produced. Contact an Applied Biosystems representative to
identify and resolve the problem.

3. Save and close the file, then unload the HRM dye calibration plate.

IMPORTANT! When you start the HRM software for the first time, you will be
prompted to select the default HRM calibration file. Select this file
(HRMCalibration_MeltDoctorDye_<instrumentinfo>_<today’s date>).
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Chapter 2

Perform an HRM Experiment

Use MeltDoctor HRM Reagents and Applied Biosystems High Resolution Melting
Software (HRM Software) to generate and analyze high-resolution melting curves from
HRM reactions run on a 7500 Fast Real-Time PCR System or a 7900HT Fast Real-
Time PCR System.

This chapter provides general instructions for performing an HRM experiment, using
the MeltDoctor'" HRM Positive Control Kit as an example.

Perform an HRM Experiment
Design the HRM experiment (below)
Prepare the HRM reactions (page 36)

Amplify and melt the DNA (page 40)

Review the high-resolution melting data (page 56)

Design the HRM experiment

Design and order  Using Primer Express® Software v3.0 or later, design the primers to amplify the
the primers  sequence of interest. Order the primers from the Applied Biosystems Store.

If you are using the MeltDoctor"” HRM Positive Control Kit, the kit contains primers
designed to amplify the alleles in the positive control DNA. You do not need to design
primers to use the Positive Control Kit.

1. Design the primers so that they meet these guidelines:

Design attribute Design guidelines

Amplicon Length is less than 250 basepairs

Primer length ~20 bases each

Tm 58 °C to 60 °C (Optimal Tm is 59 °C)

% GC content 30-80% GC content in each primer

3’ end No more than 2 G+C residues in the last 5 nucleotides
at the 3’ end

Repeating Avoid consecutive identical nucleotides. If you are

oligonucleotides unable to avoid consecutive identical nucleotides,
make sure that each primer contains fewer than 4
consecutive Gs.
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Prepare the HRM reactions

2. Go to www.appliedbiosystems.com, then log into the Applied Biosystems Store
if you have an account; register if you are a new user. For more instructions, see
“Ordering custom primers” on page 128.

Select controls  Include controls for each target sequence in your HRM experiment:

* At least one negative control

» At least one positive control to represent each expected variant (for genotyping
experiments)

Run 3 to 5 replicates for each expected variant to improve your results. Running
multiple positive controls allows you to more effectively define the natural spread
or variation within different samples of the same sequence, or within replicates of
the same genotype.

» At least one wild type control (for mutation scanning experiments)

Run up to 5 replicates for each wild type control to improve your results. Running
multiple wild type controls allows you to more effectively define the natural
spread or variation within the normal population.

Prepare the HRM reactions

Combine purified genomic DNA templates with MeltDoctor'” HRM Master Mix and
primers to amplify the target sequence.

With the MeltDoctor”™ HRM Positive Control Kit, combine positive control Allele
DNA with the MeltDoctor"™ HRM Master Mix and MeltDoctor” HRM Primer Mix to
amplify the alleles.

Note: Ifyou are using the MeltDoctor"” HRM Reagent Kit instead of the MeltDoctor"™
HRM Master Mix, see page 129 for reaction component volumes.
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Chapter 2 Perform an HRM Experiment 2
Prepare the HRM reactions

Required materials * Microcentrifuge tubes
* Optical reaction plate appropriate for your Real-Time PCR instrument
+  MicroAmp"" Optical Adhesive Film

+ For the example experiment using the MeltDoctor"™ HRM Positive Control Kit,
components from the kit:

— MeltDoctor™ HRM Primer Mix (20X)
— MeltDoctor™ HRM Allele A DNA (20X)
—  MeltDoctor™ HRM Allele G DNA (20X)
— MeltDoctor™ HRM Allele A/G DNA (20X)

* For your own HRM experiments:
— Forward and reverse primers (5 uM each)
— DNA samples

+ MeltDoctor" HRM Master Mix

* Deionized water

* Pipettors and pipette tips

* Vortexer

* Centrifuge

Prepare the HRM  Prepare the reactions for each replicate group separately, then transfer the reactions to a
reactions  reaction plate appropriate for your instrument.

To prepare HRM reactions for your own HRM experiments:

HRM experiment type See page
HRM genotyping experiments page 68
HRM mutation scanning experiments page 80
HRM methylation studies page 97

For information about using the MeltDoctor”” HRM Reagent Kit to optimize your
reactions, see “Optimizing the reaction conditions” on page 129.
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Prepare the HRM reactions

1. Prepare the negative control reactions in an appropriately sized, labeled tube:

384-well Fast reaction
plate or 96-well Fast

96-well standard reaction

reaction plate plate
Components Volume for Volume for
Volume three 20-puL Volume three 50-pL
fc2>5_onLe replicates fc5>5_onLe replicates
react:on plus 10% reachn plus 10%
excess excess
MeltDoctor™ HRM Master Mix 10 pL 33.0 L 25.0 uL 82.5 L
MeltDoctor™ HRM Primer Mix 1L 3.3 L 2.5l 8.25 uL
(20X)
Deionized water 9uL 29.7 pL 225 uL 74.25 pL
Total volume 20 uL 66 pL 50 uL 165 uL

IMPORTANT! Include excess volume in your calculations to provide excess
volume for the loss that occurs during reagent transfers. Applied Biosystems
recommends an excess volume of at least 10%.

2. Prepare the reactions using the Positive Control Kit in separate appropriately

sized, labeled tubes:

384-well Fast reaction
plate or 96-well Fast

96-well standard reaction

reaction plate plate
Components Volume Volume for Volume Volume for
for one three 20-uL for one three 50-pL
20-pL replicates 50-pL replicates
. plus 10% " plus 10%
reaction reaction
excess excess
MeltDoctor™ HRM Master Mix 10 pL 33.0 uL 25.0 uL 82.5 uL
One type of allele DNA: 1L 3.3 L 2.5 L 8.25 uL
¢ MeltDoctor™ HRM Allele A
DNA (20X)
¢ MeltDoctor™ HRM Allele G
DNA (20X)
¢ MeltDoctor™ HRM Allele A/G
DNA (20X)
MeltDoctor™ HRM Primer Mix 1pL 3.3 L 2.5 L 8.25 L
(20X)
Deionized water 8 uL 26.4 L 20.0 yL 66.0 pL
Total volume 20 uL 66 pL 50 uL 165 uL

IMPORTANT! Include excess volume in your calculations to provide excess
volume for the loss that occurs during reagent transfers. Applied Biosystems
recommends an excess volume of at least 10%.
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Prepare the HRM reactions

3. Vortex the reactions to mix, then spin the tubes briefly.

4. Prepare a reaction plate appropriate for your instrument:

a. Pipet each reaction replicate to the appropriate wells of the optical reaction

plate:
. Reaction
Reaction plate volume
Fast 384-well plate 20 yL
Fast 96-well plate 20 pL
Standard 96-well plate 50 yL

b. Seal the reaction plate with optical adhesive film, then spin the reaction plate.

c. Confirm that the liquid is at the bottom of the wells in the reaction plate.

Note: If you plan to wait more than 24 hours before running the plate, store the
plate at 4 °C. Allow the plate to warm to room temperature, then spin the plate
briefly before running it.
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Amplify and melt the DNA

Amplify and melt the DNA

After you have prepared the reaction plate, run the plate to amplify and melt the DNA
and to generate HRM fluorescence data:
* Run a 384-well plate on a 7900HT Fast instrument (page 40)
* Run a 96-well plate on a 7900HT Fast instrument (page 43)
* Run a 96-well plate on a 7500 Fast instrument with 7500 Software v2.0 (page 48)
* Run a 96-well plate on a 7500 Fast instrument with SDS Software v1.4 (page 51)

Run a 384-well plate on a 7900HT Fast instrument

Create and setupa 1. Inthe SDS Software, create a new run file for the HRM run:
new run file for the . )
HRM run Assay: Standard Curve (AQ)
* Container: 384 Wells Clear Plate
* Template: Blank Template
* (Optional) Scan or enter the barcode

2. For each target sequence in the reaction plate, create and add a detector to the
plate document:

a. Click Add Detector, then look for the detector that represents the target
sequence in your HRM reactions and the HRM dye that you are using to
detect the variants.

b. If the appropriate detector is not listed, click New, then complete the Add
Detector dialog box:
+ Name: Enter a name for the detector to identify the target sequence
* Reporter: MeltDoctor
* Quencher: Non Fluorescent

Note: SDS Software uses the term detector; the HRM software uses the term
target. When completing the Add Detector dialog box, note that the name
you assign to the detector will appear as the target name in the HRM
software.

c. Select the appropriate detector, click Copy To Plate Document, then click
Done.

d. If not already selected, select the Setup tab to view the Well Inspector.
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e. In the plate grid, select the wells that contain the detector, including negative
controls, positive controls, and sample reactions, then select the Use
checkbox for the detector that is in those wells.

Note: If you are running multiple assays, make sure you create and add a detector
for each target sequence in the plate. The HRM Software will automatically
separate the wells into different assays according to the detector assigned to the
well.

3. Set up the file to match the layout of your reaction plate:
» Indicate which wells in the reaction plate contain negative controls. Select the
negative control wells in the plate grid, then select NTC from the Task
dropdown menu.

Note: Negative controls are needed to control for the amplification, but they
are not appropriate for HRM analysis. Make sure you select the NTC task for
negative controls so that the HRM Software will automatically omit the
negative controls from the HRM analysis.

* Add sample names. For each sample, select wells in the plate grid then enter
a name for the sample.

4. Set the Passive Reference to None: Select the wells in the plate grid, then select
None from the Passive Reference dropdown menu.

Run the reaction 1. Set the thermal cycler protocol on the Thermal Profile and Ramp Rate tabs:

plate to amplify and . .
melt the DNA Mode: Standard
» Sample Volume (uL): 20

» Thermal profile:

Stage Step Temp Time F\:‘e;rtl;p
Holding Enzyme activation 95°C | 10min = 100%
Cycling (40 cycles) Denature 95°C | 15sec = 100%
Anneal/extend 60 °C 1 min 100%
Melt curve/dissociation | Denature 95°C | 10sec @ 100%
Anneal 60 °C 1 min 100%

High resolution melting | 95°C | 15sec 1%
Anneal 60°C 15sec 100%

2. Select the Real-Time tab, load the reaction plate into the instrument, then start the
run.

3. At the prompt, browse to the location where to save the file, enter a name for your
experiment, then click Save.
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4. When the Run Complete dialog box opens, click OK.

5. Save the file, then unload the reaction plate.

Verify that the 1. Click ™ (Analyze), then select the Results tab.
samples amplified
and review the Tm o Review the Amplification Plot for normal characteristics:

peaks
» Fluorescence levels that exceed the threshold between cycles 8 and 35

» An exponential increase in fluorescence

LG

aRn

Note: If the Amplification Plot looks abnormal, refer to Chapter 6,
“Troubleshooting HRM Experiments” on page 115 to identify and resolve the
problem.

3. Look for outliers with C values that differ from replicates by more than 2.

Note: Note which wells are outliers. The outliers may produce erronecous HRM
results.
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4. Verify that the Dissociation Curve shows no unexpected Tm peaks.

If the sequence you amplified contains more than 1 variant or a more complex
mutation, you may see more than 1 Tm peak because of the large differences
between the different sequence types.

Note: Unexpected peaks at low temperatures may indicate contamination, primer
dimers, or non-specific amplification.

5. Save and close the file.

6. Proceed with “Review the high-resolution melting data” on page 56.

Run a 96-well plate on a 7900HT Fast instrument

Note: If you are performing your experiment on the 7900HT instrument using a
96-well reaction plate, perform the amplification and melt curve in separate runs so
you can spin the plate before you perform the melt curve.

Create and set up a 1. In the SDS Software, create a new run file for the amplification:
new run file for the . )
amplification Assay: Standard Curve (AQ)
* Container: 96 Wells Clear Plate
* Template: Blank Template
* (Optional) Scan or enter the barcode

2. For each target sequence in the reaction plate, create and add a detector to the
plate document:

a. Click Add Detector, then look for the detector that represents the target
sequence in your HRM reactions and the HRM dye that you are using to
detect the variants.
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b. If the appropriate detector is not listed, click New, then complete the Add

Detector dialog box:
+ Name: Enter a name for the detector to identify the target sequence
* Reporter: MeltDoctor
* Quencher: Non Fluorescent

Note: SDS Software uses the term detector; the HRM software uses the term
target. When completing the Add Detector dialog box, note that the name
you assign to the detector will appear as the target name in the HRM
software.

Select the appropriate detector, click Copy To Plate Document, then click
Done.

If not already selected, select the Setup tab to view the Well Inspector.

In the plate grid, select the wells that contain the detector, including negative
controls, positive controls, and sample reactions, then select the Use
checkbox for the detector that is in those wells.

Note: If you are running multiple assays, make sure you create and add a detector
for each target sequence in the plate. The HRM Software will automatically
separate the wells into different assays according to the detector assigned to the

well.

3. Set up the file to match the layout of your reaction plate:

To indicate which wells in the reaction plate contain negative controls, select
the negative control wells in the plate grid, then select NTC from the Task
dropdown menu.

Note: Negative controls are needed to control for the amplification, but they
are not appropriate for HRM analysis. Make sure you select the NTC task for
negative controls so that the HRM Software will automatically omit the
negative controls from the HRM analysis.

Add sample names. For each sample, select wells in the plate grid then enter
a name for the sample.

4. Set the Passive Reference to None: Select the wells in the plate grid, then select
None from the Passive Reference dropdown menu.
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Run the reaction 1. Set the thermal cycler protocol on the Thermal Profile and Ramp Rate tabs:

plate to amp"f%t'\?ﬁ * Mode: Standard

» Sample Volume (uL):

— 20 pL for Fast 96-well plates

— 50 puL for standard 96-well plates

* Thermal profile:

Stage Step Temp Time F:‘aartr;p

Holding Enzyme activation 95°C | 10min = 100%
Cycling (40 cycles) Denature 95°C  15sec = 100%
Anneal/extend 60 °C 1 min 100%

2. Select the Real-Time tab, load the reaction plate into the instrument, then start the

run.

3. At the prompt, browse to the location where to save the file, enter a name for your

experiment, then click Save.

4. When the Run Complete dialog box opens, click OK.

5. Save the file, then unload the reaction plate.
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Verify that the 1. Click (Analyze), then select the Results tab.
samples amplified

2. Review the Amplification Plot for normal characteristics:
* Fluorescence levels that exceed the threshold between cycles 8 and 35

* An exponential increase in fluorescence

LG

Note: If the Amplification Plot looks abnormal, refer to Chapter 6,
“Troubleshooting HRM Experiments” on page 115 to identify and resolve the
problem

3. Look for outliers with C values that differ from replicates by more than 2.

Note: Note which wells are outliers. The outliers may produce erronecous HRM
results.

4. Save and close the file.

Create and set up a 1. In the SDS Software v2.3, create a new run file for the melt curve:
new run file for the . )
melt curve Assay: Standard Curve (AQ)
* Container: 96 Wells Clear Plate
» Template: Blank Template
* (Optional) Scan or enter the barcode

2. Set up the file to match the layout of your reaction plate, as you did for the
amplification run on page 44.
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Run the reaction  Run the reaction plate a second time to melt the DNA.
plate to melt the
DNA 1. Spin the reaction plate briefly.

2. Set the thermal cycler protocol on the Thermal Profile and Ramp Rate tabs:
* Mode: Standard
» Sample Volume (uL):
— 20 pL for Fast 96-well plates

— 50 uL for standard 96-well plates

» Thermal profile:

Stage Step Temp Time F\:‘e;rtl;p
Melt curve/dissociation | Denature 95°C 10sec 100%
Anneal 60 °C 1 min 100%
High resolution melting | 95°C | 15 sec 1%
Anneal 60°C | 15sec = 100%

3. Select the Real-Time tab, load the reaction plate into the instrument, then start the
run.

4. At the prompt, browse to the location where to save the file, enter a name for your
experiment, then click Save.

5. When the Run Complete dialog box opens, click OK.

6. Save the file, then unload the reaction plate.

Review the Tm 1. Click ™ (Analyze).
peaks

2. TIf you receive the following message, click OK.

@ This plate does not contain 3 usable PCR stage. The clipped data can not be calculated.
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3. Verify that the Dissociation Curve shows no unexpected Tm peaks.

If the sequence you amplified contains more than 1 variant or a more complex
mutation, you may see more than 1 Tm peak because of the large differences
between the different sequence types.

Note: Unexpected peaks at low temperatures may indicate contamination, primer
dimers, or non-specific amplification.

4. Save and close the file.

5. Proceed with “Review the high-resolution melting data” on page 56.

Run a 96-well plate on a 7500 Fast instrument with 7500 Software v2.0

Create and set up a
new experiment file
for the HRM run

48

1. Inthe 7500 Software, create a new experiment to amplify and melt the DNA, then
set up the file in the Experiment Properties screen:

Experiment Name — Enter a unique name for your experiment
Instrument — 7500 Fast (96 Wells)

Experiment type — Quantitation - Standard Curve

Reagents — Other, then select the Include Melt Curve checkbox
Ramp speed — Standard (~ 2 hours to complete a run)

2. Define each target sequence and each sample in the reaction plate in the Plate
Setup » Define Targets and Samples tab:

For each target sequence in the reaction plate, add a corresponding target to
the experiment: Click the Target Name cell, enter a target name, then select
MeltDoctor from the Reporter dropdown menu

For each sample in the reaction plate, add a sample name: Click Add New
Sample, then enter a sample name.
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3. Assign targets and samples to wells in the plate grid to match the layout of your
reaction plate in the Plate Setup » Assign Targets and Samples tab:

* Set up the negative controls: Select the negative control wells in the plate
grid, then select the Assign checkbox next to your target and select the D
(Negative Control) task.

Note: Negative controls are needed to control for the amplification, but they
are not appropriate for HRM analysis. Make sure you assign the Negative
Control task for negative controls so that the HRM Software will
automatically omit the negative controls from the HRM analysis.

* Set up the unknowns: Select the wells containing DNA samples in the plate
grid, then select the Assign checkbox next to your target. The m Unknown
task is selected by default.

» For each sample, select the wells that contain a sample, then select the Assign
checkbox next to the corresponding sample name.

Note: If you are running multiple assays, make sure you define each target
sequence in the plate and assign the targets to the appropriate wells. The HRM
Software will automatically separate the wells into different assays according to
the target assigned to the well.

4. Set the Passive Reference to None.

5. In the Run Method screen, set the thermal cycler conditions:
* Reaction Volume Per Well: 20 pL
* Thermal profile:

Stage Step Temp Time

Holding Enzyme activation 95°C | 10 min
Cycling (40 cycles) Denature 95°C | 15sec
Anneal/extend 60 °C 1 min

Melt curve/dissociation | Denature 95°C | 10sec
Anneal 60 °C 1 min

High resolution melting | 95°C | 15 sec

Anneal 60°C @ 15sec

* Expert Mode: Select the checkbox
* Click Select/View Filters, then select only Filter-1
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Run the plate to 1. In the navigation pane, select Run, then load the reaction plate into the
amplify and melt instrument, then click START RUN.
the DNA
Note: You may receive a message recommending SYBR® Green reagents for melt
curve experiments. Click OK to close the message.

2. At the prompt, save the file to a desired save location.

Verify that the 1. Review the Amplification Plot for normal characteristics:
samples amplified
and review the Tm

peaks * An exponential increase in fluorescence

» Fluorescence levels that exceed the threshold between cycles 8 and 35

Amplification Plot

100000000
10000000
1000000
100000

=
o 10000

<
1000 12

100

2 4 L] a AL 2 1\ 18 20 2 2 ¥ MM N 12 M ¥ B\

Cycle

Note: If the Amplification Plot looks abnormal, refer to Chapter 6,
“Troubleshooting HRM Experiments” on page 115 to identify and resolve the
problem.

2. Look for outliers with C values that differ from replicates by more than 2.

Note: Note which wells are outliers. The outliers may produce erronecous HRM
results.
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3. Verify that the Melt Curve shows no unexpected Tm peaks.

If the sequence you amplified contains more than 1 variant or a more complex
mutation, you may see more than 1 Tm peak because of the large differences
between the different sequence types.

Note: Unexpected peaks at low temperatures may indicate contamination, primer
dimers, or non-specific amplification.

Note: The data appear noisy because the single filter read in Expert Mode (Filter
1) results in an increase in data collection. The extra data are required for analysis
with the High Resolution Melting Software.

= Reporer =] Target [ =1 color [wen =

ngs as the default

a b = =
Melt Curve

4. Save and close the file.

5. Proceed with “Review the high-resolution melting data” on page 56.
Run a 96-well plate on a 7500 Fast instrument with SDS Software v1.4

Create and setupa 1. Inthe SDS Software, create a new run file for the amplification:

new run file for the . ) o
HRM run Assay: Standard Curve (Absolute Quantitation)

* Container: 96-Well Clear
+ Template: Blank Document

2. For each target sequence in the reaction plate, create and add a detector to the
plate document:

a. Enter a name for the detector, select MeltDoctor for the Reporter Dye, then
click OK.

Note: SDS Software uses the term detector; the HRM software uses the term
target. When completing the New Detector dialog box, note that the name
you assign to the detector will appear as the target name in the HRM
software.
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b. Select the detector from the list, then click Add.

Note: If you are running multiple assays, make sure you create and add a detector
for each target sequence in the plate.

3. Set up the plate grid to match the layout of your reaction plate:

a. To indicate which detector is in being used in each well, select the wells that

contain a particular detector, including negative controls, positive controls,
and sample reactions, then select the Use checkbox for the corresponding
detector.

Note: If you are running multiple assays, make sure you indicate the detector
used in each well. The HRM Software will automatically separate the wells
into different assays according to the detector assigned to the well.

. To indicate which wells in the reaction plate contain negative controls, select

the negative control wells in the plate grid, then select NTC from the Task
dropdown menu.

Note: Negative controls are needed to control for the amplification, but they
are not appropriate for HRM analysis. Make sure you select the NTC task for
negative controls so that the HRM Software will automatically omit the
negative controls from the HRM analysis.

. Add sample names. For each sample, select wells in the plate grid then enter

a name for the sample.

d. From the Passive Reference dropdown menu, select (none).
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Run the plate to 1. Set the thermal cycler protocol in the Instrument » Thermal Profile tab:

amplify and melt

the DNA * Thermal profile:

Stage Step Temp Time

Holding Enzyme activation 95°C | 10 min

Cycling (40 cycles) Denature 95°C | 15sec

Anneal/extend 60 °C 1 min

Melt curve/dissociation | Denature 95°C | 10sec

Anneal 60 °C 1 min

High resolution melting | 95°C | 15sec

Anneal 60°C @ 15sec

» Sample Volume (uL): 20
* Run Mode: Fast 7500
* Expert Mode: Select the checkbox

* Click Select/View Filters, then select only Filter A

2. Load the reaction plate into the instrument, then start the run.

3. At the prompt, browse to the location where to save the file, enter a name for your

experiment, then click Save.

4. When the Run completed successfully message appears, click OK.

5. Save the file, then unload the reaction plate.
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Verify that the
samples amplified
and review the Tm

peaks

54

1. Click ® (Analyze), then select the Results tab.

2. View the Amplification Plot, then review the plot for normal characteristics:
* Fluorescence levels that exceed the threshold between cycles 8 and 35

* An exponential increase in fluorescence

Setup ¥ Instrument YResults |
PlateSpectra } Component Y Amplification Plot { Standard Curve YDissociation YReport |
Detta Rn vs Cycle o
100084007
Dete: [DetaPnvs Oycle v
Detector: [Al ~
1.0002+005
—— | Line Color: [well Color v
= =
1.000e+005
- Analysis Settings
1.0008+004 @ Aot
! € Manual Ct
& 1
S 10006003 | Threshold: [12
2 7 v T
= @ Auto Baseline
1000e+002 / € Menuzl Baseline
[Pt
1.0008+001 St (evele) [Buto
/ End (cycle): [Auto
1.0002+000
Analyze

12 3 4 5 6 7 8 9 1011 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 3 W 40

Cycle Number

Note: If the Amplification Plot looks abnormal, refer to Chapter 6,
“Troubleshooting HRM Experiments” on page 115 to identify and resolve the
problem.

3. Look for outliers with C values that differ from replicates by more than 2.

Note: Note which wells are outliers. The outliers may produce erronecous HRM
results.
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4. View the Dissociation Curve, then verify that the curve shows no unexpected Tm
peaks.

If the sequence you amplified contains more than 1 variant or a more complex
mutation, you may see more than 1 Tm peak.

Note: Unexpected peaks may indicate contamination, primer dimers, or non-
specific amplification.

Note: The data appear noisy because the single filter read in Expert Mode (Filter
A) results in an increase in data collection. The extra data are required for analysis
with the High Resolution Melting Software.

Setup ¥ Instrument YResults |
Plate}Spectray Component ¥ ification Plot ¥ Standard Curve YDissociation {Report |
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400064004
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2.000e+004

1.0008+004
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0.000e+000 [

-1.0008+004

-2.0008+004

-3.0008+004

Temperature (C)

5. Save and close the file.

6. Proceed with “Review the high-resolution melting data” on page 56.
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Review the high-resolution melting data
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Start the HRM
Software

Access the HRM
Help system

About the HRM
calibration file

Example HRM
experiments

Create the HRM
experiment

After you create, run, and analyze the *.eds or *.sds file on the 7900HT Fast or 7500
Fast system, use the Applied Biosystems High Resolution Melting Software (HRM
software) to perform high resolution melting analysis of the data and review the
variants.

Start the HRM Software:
* On the desktop, double-click M (HRM v2.0 or later)

or

* Select Start » All Programs » Applied Biosystems » HRM » HRMv2.0 (or
later)

The HRM software has a Help system that describes how to use each feature of the
software. Access the HRM Software Help by doing one of the following:

« Click ¥ in the software window

* Select Help » HRM Help

* Press F1

The HRM calibration file is the *.eds or *.sds file that you created, ran, and analyzed
on the 7500 Fast or 7900HT Fast System during the HRM calibration (see Chapter 1).

When you create an HRM experiment file in the HRM Software, the software assigns
an HRM calibration file to the HRM run file. The data from the HRM calibration file
are used in the HRM analysis.

The first time that you create an HRM experiment file in the HRM Software, select the
default HRM calibration file to assign to HRM experiment files.

To view an example of an HRM experiment, use the example files that are installed
with the HRM software:

* 384well Genotyping Example.hrm

*  96well Genotyping Example.hrm

The files are located in X:\Applied Biosystems\HRM\experiments, where X is the drive
where you installed the HRM Software.

Create an HRM experiment in the HRM Software using the *.eds or *.sds run file from
your 7900HT Fast or 7500 Fast system.

The HRM software uses the default analysis settings to automatically assign a variant
call to each sample. The software determines the variant calls by melt curve
characteristics — melt curve shapes and Tm values. Before you assign the controls, the
software labels each variant call variantl, variant2, variant3, and so on.
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1. Using the HRM Software, select File » Open from the menu bar or click
in the toolbar.
2. Browse to and select the *.eds or *.sds file to undergo HRM analysis.
3. If this is your first time to open an HRM run file, the Open Calibration File dialog

box opens. Browse to and select the HRM calibration file to use as the default
HRM calibration file.

IMPORTANT! Use the HRM calibration file name to make sure that the HRM
calibration file that is assigned to the HRM experiment is correct. The HRM
calibration file must be:

* Run on the same instrument system (the same instrument, the same block type,
and the same software version) as the run file

* Run using the same HRM dye and master mix used in the HRM calibration
plate

The HRM Software cannot distinguish between all calibration files. For example,
it cannot distinguish between two different 7500 v2.0 instruments or between a
7900HT instrument with the Fast 96-well block and a 7900HT instrument with a
standard 96-well block.

Note: If you cannot see the Browse button, resize the dialog box.

To change the HRM calibration file for a selected experiment or to change the
default HRM calibration file for subsequent new HRM experiments, see “Change
the HRM calibration file” on page 131.

4. Click OK.

A new HRM experiment appears in the HRM Experiments pane. The default
name is the name of the *.eds or *.sds file you opened in step 2.

Note: An HRM experiment is an *.hrm file that contains one run file and one
HRM calibration file. Each HRM experiment in the software appears as a folder
icon 4 in the HRM Experiments pane; expand the folder to view the HRM run
file and HRM calibration file names.

5. Save the new HRM experiment:
a. In the HRM Experiments pane, select the new HRM experiment.

b. In the toolbar, click .

c. Browse to and select a save location, then accept the default name or enter a
new name for the HRM experiment.
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d. Click Save.
The new HRM experiment is saved as an *.hrm file.

Note: You cannot open a run file or an HRM experiment by double-clicking
the file icon (*.eds, *.sds, or *.hrm file) from outside the HRM Software.

About the melting  The melting profile of a PCR product depends on its GC content, length, sequence, and
profiles  heterozygosity. High-resolution melting analysis calls variants based on the differences
in the shape of the melt curves and the differences in the Tm values.

With the MeltDoctor'™ HRM Positive Control Kit:

The heterozygotes have a different curve shape compared to the wild type
homozygote and the variant homozygote. The shape of the melt curve is an
indicator of heteroduplex formation.

The two homozygotes are distinguished from each other based on the difference in
Tm values.

About the pre- and In the Derivative Melt Curves plot and the Raw Melt Curves plot, there are two sets of

post-melt regions  Jipes
data
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before and after the data peak. The pre- and post-melt regions are used to scale the
in the Aligned Melt Curves and Difference Plot.

Pre-melt region: The set of lines to the left of the peak indicate the pre-melt Start
and Stop temperatures when every amplicon is double-stranded.
Fluorescence data from the pre-melt region correspond to 100% fluorescence.

Active melt region: The data peak indicates the active melt region of the plot. For
each sample, the change in fluorescence to the right of the 100% fluorescence
point correspond to the true fluorescence change. Data from the active melt region
are used to plot the Aligned Melt Curves.

Note: In methylation studies, the Derivative Melt Curves plot typically displays
multiple peaks.

Post-melt region: The set of lines to the right of the peak indicate the post-melt
Start and Stop temperatures when every amplicon is single-stranded.

Fluorescence data from the post-melt region correspond to 0% fluorescence.

Derivative Melt Curves
79.50.53 36 87.86
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8
8
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Temperature (C)
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Review the pre- When you create a new HRM experiment, the software calculates the pre- and post-
and post-melt  melt regions automatically. Review and adjust the pre- and post-melt regions to
regions  ptimize your separation and variant calls. For most experiments, set the pre- and post-
melt regions as close as possible to the melting transition region.

1. In the Data pane, select the Derivative Melt Curves tab.
2. Press Ctrl+A to select all the wells.

3. Set the pre-melt region:

a. Click and drag the pre-melt Stop temperature line (red arrow on the left)
adjacent to the start of the melting transition region.

b. Click and drag the pre-melt Start temperature line (green arrow on the left)
approximately 0.2 to 0.5 °C from the pre-melt Stop temperature line.

79.&].53 Sﬁ.hﬁf.sﬁ

Set the pre-melt Stop next to the
start of the melting transition

Set the pre-melt Start ~0.2 t0 0.5 °C
from the pre-melt Stop

Note: The pre-melt region should be within a flat area where there are no large
spikes or slopes in the fluorescent levels.

4. Set the post-melt region:

a. Click and drag the post-melt Start temperature line (green arrow on the right)
adjacent to the end of the melting transition region.
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b. Click and drag the post-melt Stop temperature line (red arrow on the right)
approximately 0.2 to 0.5 °C from the post-melt Start temperature line.

TD.&].SS Sﬁ.hﬂT.Sﬁ

65.0 &7.5 70.0 7285 75.0 778 “Eo 4~ 82.5 85.0 7 80.0 825 85.0

Set the post-melt Start next to the end of
the melting transition

Set the post-melt Stop ~0.2 to 0.5 °C from
the post-melt Start

Note: The post-melt region should be within a flat area where there are no large
spikes or slopes in the fluorescent levels.

5. Click [£:#nabee]

The software reanalyzes the data using the new pre- and post-melt regions. In both
the Analyzed Data and Data panes, the color of the melt curves changes to reflect
the new results.

For each positive control sample, enter information about that control in the HRM
software and assign the control to the appropriate wells.

Note: Negative control samples that were designated as NTCs or Negative Controls
using the instrument software are automatically omitted from analysis in the HRM
Software.

1. In the toolbar, click _

2. On the Assign Controls tab, click Add.
3. In the Control Name field, enter a name for a control sample.
Note: For control names, do not use the convention variantN, where N is any

number (for example, variantl, variant2, and so on). The HRM software uses the
convention variantN when automatically assigning the variant calls.

4. From the Well dropdown list, select the well that contains the sample to use as the
control.
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Chapter 2 Perform an HRM Experiment 2
Review the high-resolution melting data

5. Select the color to display in the plots for this control.
6. Repeat step 2 through step 5 to assign the remaining controls.

Note: For control replicates, enter a name and select a color identical to the other
control replicates. You can enter up to 5 replicates for each control.

The example experiment file, 384well Genotyping Example.hrm, contains the
following controls:

Contral Mame Well Calar
Hom - wild bype At - -
Hom - wild bype P18 - -
Harn - variant A3 Ll . v
Horm - variant Pzl ﬂ‘. b
Heterozygote A2 ﬂ‘. -
Heterozygate Ez2 ﬂ‘. -

7. Click Analyze to reanalyze the data with the controls assigned.

Note: In the Results pane, the variant call for the sample(s) you selected is
renamed using the convention Control-<name>, where <name> is the name you
entered in step 3.

The Aligned Melt Curves plot displays the melt curves as % melt (0 - 100%) over
temperature. The melt curves are aligned to the same fluorescence level using the pre-
and post-melt regions that you set (see page 59).

1. Inthe Analyzed Data pane, select the Aligned Melt Curves tab.

2. Review:

* Variant groups (different colors) — How many different variant groups are
displayed? Does this number correspond to the number of variants you were
expecting?

* Qutliers — Are there any curves within a variant group that do not cluster
tightly with the other samples in that group?
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outliers

Difference Plot
example

Review the
software calls

Chapter 2 Perform an HRM Experiment
Review the high-resolution melting data

In the example below, there are 3 distinct variant groups, 1 for each genotype. The wild
type control (homozygote) is selected as the reference (green curves).

The Difference Plot displays the aligned data as the difference in fluorescence between
the melt curve for a reference sample and the other melt curves. You can select a
control or any well as a reference. After you select the reference, the software subtracts
the reference curve from the other curves.

The Difference Plot allows you to more easily see small differences between curves
and identify outliers.

1. Inthe Analyzed Data pane, select the Aligned Data - Difference Plot tab.

2. From the Reference dropdown menu, select a control or any well as the reference,
then review:

* Variant clusters — How many distinct clusters are displayed?
* OQutliers — How tight are the curves within each variant cluster?

Note: Try selecting different reference samples to find the optimal display of the
clusters.

In the example below, there are 3 distinct variant groups, 1 for each genotype. The wild
type control (homozygote) is selected as the reference (green curves).

Difference Plot

Difference
o
o

825 83.0 835
Temperature (C)

The High Resolution Melting Software automatically makes a call for each sample
according to the shape of the aligned melt curves and the Tm. Review the software
calls, then omit outliers or change calls.
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Review the high-resolution melting data

1. In the Results pane, click the Well column header to sort the results according to
the well position.

2. For the positive controls, review:

* Variant Call column — Do all of the positive control replicates have the
correct call?

* Confidence column — Are there any outliers within the replicate group? Do
the values for the replicate group differ greatly from the confidence values
for other replicate groups in the plate?

Note: If any of the controls are outliers, omit them from the HRM analysis,
then reanalyze.

3. For each replicate group, review:
* Variant Call column — Do all replicates have the same call?

» Confidence column — Are there any outliers within the replicate group? Do
the values for the replicate group differ greatly from the confidence values
for other replicate groups in the plate?

4. To view the fluorescence data for certain wells, select the rows in the Results
table.

5. In the Results pane, click the Variant Call column header to sort the results

according to the variant call. For each variant call, review the samples that were
assigned that call.

Omit outliers from  After you review the data, omit outliers from the analysis. You can omit outliers in the
analysis  Data pane, Analyzed Data pane, or Results pane.

Note: Try omitting outliers from the Difference Plot, where the variance is easily
visualized.

1. Select the outliers, then omit the wells:

Pane Procedure
Data or Analyzed 1. Click and drag in the Raw Melt Curves, Derivative Melt
Data pane Curves, Aligned Melt Curves, or Difference Plot to create a

box and select one or more outlier curves.
The color of the selected curves changes.
2. Right-click, then select Omit Wells.

Results pane 1. Select the Omit checkbox for any well to omit from the HRM
analysis.

2. Click . The software omits data from the selected wells and reanalyzes the
remaining data.
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Change calls made If you do not agree with the call automatically made by the software (Auto call), you
by the software  can manually change the call in the Analyzed Data pane or the Results pane.

1. Select samples, then manually change the call:

Pane Procedure
Analyzed Data 1. Click and drag in the Aligned Melt Curves or Difference Plot
pane to create a box and select one or more curves with a call to
change.

The color of the selected curves changes.

2. Right-click, then select Manual call. To change the call to:

¢ A call that has already been made for other samples:
Select the appropriate call from the dropdown menu.

e A new call: Click New, enter a name for the new call, click
OK, select a color, then click OK.

Results pane 1. Click the cell in the Variant Call column for the call to
change.
2. From the dropdown menu, you can change the call to:

e A call that has already been made for other samples:
Select the appropriate call from the dropdown menu.

¢ A new call: Select Manual call. In the dialog box, enter a
name for the new call, select a color, then click OK.

In the Comments column, Manual call appears next to the
sample.

2. Click . The software reanalyzes the data using your manual calls.

Revert selected If you want to remove a manual call for selected samples, you can revert the manual
manual calls to the  call to the call automatically made by the software (Auto call) in the Analyzed Data

software Auto call

pane or the Results pane.

1. Select samples, then revert the manual call:

Pane Procedure
Analyzed Data 1. Click and drag in the Aligned Melt Curves or Difference Plot
pane to create a box and select one or more curves with a manual
call to revert.

The color of the selected curve(s) changes.
2. Right-click, then select Auto call.
Results pane 1. Click the cell in the Variant Call column for the call to revert.
2. Select Auto call from the dropdown menu.

2. Click . The software reanalyzes the data using the calls for the selected
samples.

Revert all manual If you want to remove all manual calls for all samples in the plate, you can revert all

calls to the  manual calls to the call automatically made by the software (Auto call).

software Auto call
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1. Inthe toolbar, select [ 5t Assion Cantral '
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2. Select the Remove All Manual Calls checkbox.

3. Click . The software reanalyzes the data using the software Auto call for
all samples.
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Chapter 3

Perform an HRM Genotyping Experiment

Perform an HRM genotyping experiment to determine the genotype of a DNA sample.
Perform an HRM Genotyping Experiment

Design the HRM experiment (below)
Prepare the HRM reactions (page 68)
Amplify and melt the DNA (page 71)

Review the high-resolution melting data (page 74)

Design the HRM experiment

Design and order  Using Primer Express® Software v3.0 or later, design the primers to amplify the
the primers  genomic DNA that contains the single nucleotide polymorphism (SNP) of interest.
Order the primers from the Applied Biosystems Store.

1. Design the primers so that they meet these guidelines:

Design attribute Design guidelines

Amplicon ¢ Length is less than 250 basepairs
e Contains only 1 SNP

Primer length ~20 bases each

Tm 58 °C to 60 °C (Optimal Tm is 59 °C)

% GC content 30-80% GC content in each primer

3’ end No more than 2 G+C residues in the last 5 nucleotides
at the 3’ end

Repeating Avoid consecutive identical nucleotides. If you are

oligonucleotides unable to avoid consecutive identical nucleotides,

make sure that each primer contains fewer than 4
consecutive Gs.

2. Go to www.appliedbiosystems.com, then log into the Applied Biosystems Store
if you have an account; register if you are a new user. For more instructions, see
“Ordering custom primers” on page 128.
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3 Chapter 3 Perform an HRM Genotyping Experiment
Prepare the HRM reactions

Select controls

Include controls for each SNP sequence in your HRM genotyping experiment:

At least one negative control

At least one positive control to represent each expected genotype

Run 3 to 5 replicates for each expected genotype to improve your results. Running
multiple positive controls allows you to more effectively define the natural spread
or variation within different samples of the same sequence, or within replicates of
the same genotype.

Prepare the HRM reactions

Required materials

Prepare the HRM
reactions

68

Combine purified genomic DNA templates with MeltDoctor™ HRM Master Mix and
primers to amplify the target sequence.

Note: Ifyou are using the MeltDoctor” HRM Reagent Kit instead of the MeltDoctor"
HRM Master Mix, see page 129 for reaction component volumes.

Microcentrifuge tubes
Optical reaction plate appropriate for your Real-Time PCR instrument
MicroAmp"™ Optical Adhesive Film
MeltDoctor™ HRM Master Mix
For each target sequence:
— Forward and reverse primers (5 uM each)
— DNA samples
Deionized water
Pipettors and pipette tips
Vortexer
Centrifuge

Prepare the reactions for each replicate group separately, then transfer the reactions to a
reaction plate appropriate for your instrument.

For information about using the MeltDoctor"” HRM Reagent Kit to optimize your
reactions, see “Optimizing the reaction conditions” on page 129.
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Prepare the HRM reactions

1. Prepare the negative control reactions in an appropriately sized, labeled tube:

384-well Fast reaction
plate or 96-well Fast

96-well standard reaction

reaction plate plate
Gomeonents Volume L Volume oL
20-pL rep;.ilcl:Jastes 50-pL rep‘!.ilcl:Jastes
reaction 10% excess reaction 10% excess
MeltDoctor™ HRM Master Mix 10.0 L 33.00 pL 25.0 L 82.5 uL
Primer 1 (5 M) 1.2 yL 3.96 pL 3.0 L 9.9 uL
Primer 2 (5 uM) 1.2 uL 3.96 pL 3.0 uL 9.9 uL
Deionized water 7.6 uL 25.08 pL 19.0 uL 62.7 pL
Total reaction volume 20.0 L 66.00 pL 50.0 L 165.0 pL

IMPORTANT! Include excess volume in your calculations to provide excess
volume for the loss that occurs during reagent transfers. Applied Biosystems
recommends an excess volume of at least 10%.

2. Prepare positive control reactions and unknown reactions in separate appropriately

sized, labeled tubes:

384-well Fast reaction .
plate or 96-well Fast 96-well standard reaction
. plate
reaction plate
Components Volume Volume for Volume Volume for
for one three 20-uL for one three 50-pL
20-pL replicates 50-pL replicates
. plus 10% " plus 10%
reaction reaction
excess excess
MeltDoctor™ HRM Master Mix 10.0 L 33.00 pL 25.0 yL 82.5 uL
Primer 1 (5 M) 1.2 L 3.96 pL 3.0 uL 9.9 uL
Primer 2 (5 pM) 1.2 yL 3.96 pL 3.0 L 9.9 uL
Genomic DNA (20 ng/uL) 1.0 yL 3.30 pL 2.5 L 8.25 L
Deionized water 6.6 uL 21.78 uL 16.5 uL 54.45
Total reaction volume 20 yL 66 pL 50 uL 165 uL

IMPORTANT! Include excess volume in your calculations to provide excess
volume for the loss that occurs during reagent transfers. Applied Biosystems
recommends an excess volume of at least 10%.

3. Vortex the reactions to mix, then spin the tubes briefly.
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Prepare the HRM reactions

4. Prepare a reaction plate appropriate for your instrument:

a. Pipet each reaction replicate to the appropriate wells of the optical reaction

plate:
. Reaction
Reaction plate volume
Fast 384-well plate 20 yL
Fast 96-well plate 20 pL
Standard 96-well plate 50 L

b. Seal the reaction plate with optical adhesive film, then spin the reaction plate.

c. Confirm that the liquid is at the bottom of the wells in the reaction plate.

Note: If you plan to wait more than 24 hours before running the plate, store the
plate at 4 °C. Allow the plate to warm to room temperature, then spin the plate
briefly before running it.
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Amplify and melt the DNA

After you have prepared the reaction plate, run the plate to amplify and melt the DNA
and to generate HRM fluorescence data. This chapter contains brief instructions. For

detailed instructions, see:

Chapter 3 Perform an HRM Genotyping Experiment
Amplify and melt the DNA

* Run a 384-well plate on a 7900HT Fast instrument (page 40)

* Run a 96-well plate on a 7900HT Fast instrument (page 43)

* Run a 96-well plate on a 7500 Fast instrument with 7500 Software v2.0 (page 48)
* Run a 96-well plate on a 7500 Fast instrument with SDS Software v1.4 (page 51)

Create and set up
the HRM run file

Run file setting

7900HT Fast System with
SDS Software v2.3 or later

7500 Fast System with

7500 Software v2.0 or later

7500 Fast Real-Time PCR
System with SDS Software

vi4

Document/
experiment

Detector/target
and plate layout

Assay: Standard Curve
(AQ)

Container: 384 Wells Clear
Plate or 96 Wells Clear
Plate

Template: Blank Template

Reporter: MeltDoctor

Quencher: Non
Fluorescent

Instrument: 7500 Fast (96
Wells)

Experiment type:
Quantitation - Standard
Curve

Reagents: Other, then
select the Include Melt
Curve checkbox

Ramp speed: Standard (~ 2
hours to complete a run)
Reporter: MeltDoctor
Quencher: None

e Assay: Standard Curve

(Absolute Quantitation)
Container: 96-Well Clear
Template: Blank Document

Reporter: MeltDoctor

Quencher: Non
Fluorescent

Plate layout

Thermal
profile/run method

Task for negative control
wells: NTC

Passive Reference: None

Mode: Standard

Sample Volume (uL): 20
(384-well or 96-well Fast) or
50 (96-well standard)

Task for negative control
wells: [ ]

Passive Reference: None
Reaction Volume Per Well:
20 uL

Expert Mode: Select the
checkbox

Click Select/View Filters,
then select only Filter-1

Task for negative control
wells: NTC

Passive Reference: (none)

Sample Volume (uL): 20
Run Mode: Fast 7500

Expert Mode: Select the
checkbox

Click Select/View Filters,
then select only Filter A
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Amplify and melt the DNA

Run the plate Note: If you are performing your experiment on the 7900HT Fast instrument using a
96-well reaction plate, perform the melt curve in a separate run because you need to
spin the plate after you amplify the DNA.

Ramp
Stage Step Temp Time (7;3:)?_”
only)
Holding Enzyme activation 95°C | 10 min 100%
Cycling (40 cycles) Denature 95°C | 15sec 100%
Anneal/extend 60 °C 1 min 100%
Melt curve/dissociation | Denature 95°C | 10sec 100%
Anneal 60 °C 1 min 100%
High resolution melting | 95°C | 15sec 1%
Anneal 60°C @ 15sec 100%

Verify that the 1. Review the Amplification Plot for normal characteristics:

samples amplified .
and review the Fluorescence levels that exceed the threshold between cycles 8 and 35

peaks in the melt * An exponential increase in fluorescence

curve
ILFERGEY

Note: Note which wells are outlierswith C; values that differ from replicates by
more than 2. The outliers may produce erroneous HRM results.

Note: If the Amplification Plot looks abnormal, refer to Chapter 6,
“Troubleshooting HRM Experiments” on page 115 to identify and resolve the
problem.
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Amplify and melt the DNA

2. Verify that the Dissociation Curve/Melt Curve shows no unexpected Tm peaks:

If the sequence you amplified contains more than 1 SNP or a more complex
mutation, you may see more than 1 Tm peak.

Note: Unexpected peaks may indicate contamination, primer dimers, or non-
specific amplification.

Note: The data appear noisy because more data is collected during a high
resolution melt curve than during a standard melt curve. The extra data are
required for analysis with the High Resolution Melting Software.
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Review the high-resolution melting data

Review the high-resolution melting data

74

Example HRM
experiments

Create and set up
the HRM
experiment

After you create, run, and analyze the *.eds or *.sds file on the 7900HT Fast or 7500
Fast system, use the Applied Biosystems High Resolution Melting Software (HRM
software) to perform high resolution melting analysis of the data and make genotype
calls.

To view an example of an HRM genotyping experiment, use the example files that are
installed with the HRM software:

» 384well Genotyping Example.hrm

* 96well Genotyping Example.hrm

* 96well Class 4 SNP Example.hrm

The files are located in X:\Applied Biosystems\HRM\experiments, where X is the drive
where you installed the HRM Software.

For more detailed instructions on how to create and set up an HRM experiment, see
pages 56 through 60.

1. Create an HRM experiment in the HRM Software using the *.eds or *.sds run file
from your 7900HT Fast or 7500 Fast system.

Note: If this is your first time creating an HRM experiment with the HRM
software, select the default HRM calibration file. To change the HRM calibration
file for a selected experiment or for all subsequent HRM experiments, see
“Change the HRM calibration file” on page 131.

IMPORTANT! Use the HRM calibration file name to make sure that the HRM
calibration file that is assigned to the HRM experiment is correct. The HRM
calibration file must be:

* Run on the same instrument system (the same instrument, the same block type,
and the same software version) as the run file

* Run using the same HRM dye and master mix used in the HRM calibration
plate

The HRM Software cannot distinguish between all calibration files. For example,
it cannot distinguish between two different 7500 v2.0 instruments or between a
7900HT instrument with the Fast 96-well block and a 7900HT instrument with a
standard 96-well block.
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Review the high-resolution melting data

2. In the Derivative Melt Curves plot, review and adjust the pre- and post-melt
regions to optimize your separation and variant calls. For most experiments, set
the pre- and post-melt regions as close as possible to the melting transition region:

* The pre-melt Start and Stop temperature lines (green and red arrows on the
left) should be approximately 0.2 to 0.5 °C apart from each other.

TD.&].SS Sﬁ.bﬁT.Sﬁ

Set the pre-melt Stop next to the
start of the melting transition

Set the pre-melt Start ~0.2 to 0.5 °C
from the pre-melt Stop

» The post-melt Start and Stop temperature lines (green and red arrows on the
right) should be approximately 0.2 to 0.5 °C apart from each other.

79.&].53 Sﬁ.hﬁf.sﬁ

T e e

65.0 67.5 70.0 72.5 75.0 778 “Ho 4~ B82.5 B85.0 e 20.0 925 95.0

Set the post-melt Start next to the end of
the melting transition

Set the post-melt Stop ~0.2 to 0.5 °C from
the post-melt Start
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About the melting
profiles

Review the
populations in the
Aligned Melt
Curves plot

76

For each control sample, enter information about that control in the HRM
Software and assign the control to the appropriate wells.

The example experiment file, 384well Genotyping Example.hrm, contains the
following controls:

Cantrol Name el Calor
Hom - wild bype Ad w v
Hom - wild bype P18 - -
Horm - variant A3 Ll . b
Horm - variant Pzl ﬂ‘. b
Heterozygote Az ﬂ‘. -
Heterozygote Ez2 ﬂ‘. -

Note: For control names, do not use the convention variantN, where N is any
number (for example, variantl, variant2, and so on). The HRM Software uses the
convention variantN when automatically assigning the variant calls.

The melting profile of a PCR product depends on its GC content, length, sequence, and
heterozygosity. High-resolution melting analysis calls variants based on the differences
in the shape of the melt curves and the differences in the Tm values.

In genotyping experiments:

The heterozygotes have a different curve shape compared to the wild type
homozygote and the variant homozygote. The shape of the melt curve is an
indicator of heteroduplex formation.

The two homozygotes are distinguished from each other based on the difference in
Tm values.

The Aligned Melt Curves plot displays the melt curves as % melt (0 - 100%) over
temperature. The melt curves are aligned to the same fluorescence level using the pre-
and post-melt regions that you set (see page 74).

1.

In the Analyzed Data pane, select the Aligned Melt Curves tab.

2. Review:

* Variant groups (different colors) — How many different variant groups are
displayed? Does this number correspond to the number of variants you were
expecting?

* Outliers — Are there any curves within a variant group that do not cluster
tightly with the other samples in that group?
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Review the high-resolution melting data

Aligned Melt  In the example below, there are 3 distinct variant groups, 1 for each genotype. The wild
Curves example  type control (homozygote) is selected as the reference (green curves).

Review the The Difference Plot displays the aligned data as the difference in fluorescence between
Difference Plot for  the melt curve for a reference sample and the other melt curves. You can select a
outliers .01 or any well as a reference. After you select the reference, the software subtracts
the reference curve from the other curves.

The Difference Plot allows you to more easily see small differences between curves
and identify outliers.

1. Inthe Analyzed Data pane, select the Aligned Data - Difference Plot tab.

2. From the Reference dropdown menu, select the wild type control as the reference,
then review:

* Variant clusters — How many distinct clusters are displayed?
* OQutliers — How tight are the curves within each variant cluster?

Difference Plot In the example below, there are 3 distinct variant groups, 1 for each genotype. The wild
example  type control (homozygote) is selected as the reference (green curves).

Difference Plot

Difference
o
o

2.5 83.0 835
Temperature (C)
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Review the high-resolution melting data

Review the The High Resolution Melting Software automatically makes a call for each sample
software calls  according to the shape of the aligned melt curves and the Tm. Review the software
calls, then omit outliers or change calls.

1. In the Results pane, click the Well column header to sort the results according to
the well position.

2. For the positive controls, review:

* Variant Call column — Do all of the positive control replicates have the
correct call?

» Confidence column — Are there any outliers within the replicate group? Do
the values for the replicate group differ greatly from the confidence values
for other replicate groups in the plate?

Note: If any of the controls are outliers, omit them from the HRM analysis,
then reanalyze.

3. For each replicate group, review:
* Variant Call column — Do all replicates have the same call?

* Confidence column — Are there any outliers within the replicate group? Do
the values for the replicate group differ greatly from the confidence values
for other replicate groups in the plate?

4. To view the fluorescence data for certain wells, select the rows in the Results
table.

5. In the Results pane, click the Variant Call column header to sort the results
according to the variant call. For each variant call, review the samples that were
assigned that call.

Omit outliers or  After you review the software calls, you can omit outliers or change calls. Remember
change calls {0 click to reanalyze the data after you omit outliers or change calls.

For more detailed instructions, see pages 63 and 64:

*  Omit outliers from analysis

* Change calls made by the software

* Revert selected manual calls to the software Auto call
* Revert all manual calls to the software Auto call
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Perform an HRM Mutation Scanning
Experiment

Perform an HRM mutation scanning experiment to screen DNA samples for new
single-base changes, insertions/deletions, or other unknown mutations.

Perform an HRM Mutation Scanning Experiment
Design the HRM experiment (below)
Prepare the HRM reactions (page 80)
Amplify and melt the DNA (page 83)

Review the high-resolution melting data (page 86)

Sequence the variants (page 91)

Design the HRM experiment

Design and order  Using Primer Express® Software v3.0 or later, design the primers to amplify the
the primers  genomic DNA that spans the mutations of interest. Order the primers from the
Applied Biosystems Store.

1. Design the primers so that they meet these guidelines:

Design attribute Design guidelines

Amplicon Length is less than 250 basepairs

Primer length ~20 bases each

Tm 58 °C to 60 °C (Optimal Tm is 59 °C)

% GC content 30-80% GC content in each primer

3’ end No more than 2 G+C residues in the last 5 nucleotides
at the 3’ end

Repeating Avoid consecutive identical nucleotides. If you are

oligonucleotides unable to avoid consecutive identical nucleotides,
make sure that each primer contains fewer than 4
consecutive Gs.
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Prepare the HRM reactions

2. If you want to use M13F and M13R primers in the sequencing reaction, add the
appropriate M 13 tail to the 5" end of the primers:

*  MI13F (add to the 5" end of the forward primer):
TGTAAAACGACGGCCAGT

* MI13R (add to the 5" end of the reverse primer):
CAGGAAACAGCTATGACC

3. Go to www.appliedbiosystems.com, then log into the Applied Biosystems Store
if you have an account; register if you are a new user. For more instructions, see
“Ordering custom primers” on page 128.

Select controls  Include controls for each target sequence in your HRM mutation scanning experiment:

+ At least one negative control
* At least one wild type control

Run up to 5 replicates for each wild type control to improve your results. Running
multiple wild type controls allows you to more effectively define the natural
spread or variation within the normal population.

Prepare the HRM reactions

Required materials * Microcentrifuge tubes

* Optical reaction plate appropriate for your Real-Time PCR instrument

+  MicroAmp™ Optical Adhesive Film

+ MeltDoctor HRM Master Mix

» For each target sequence:
— Forward and reverse primers (5 uM each)
— DNA samples

* Deionized water

* Pipettors and pipette tips

* Vortexer

» Centrifuge
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Prepare the HRM

reactions

Chapter 4 Perform an HRM Mutation Scanning Experiment
Prepare the HRM reactions

Prepare the reactions for each replicate group separately, then transfer the reactions to a
reaction plate appropriate for your instrument.

For information about using the MeltDoctor"” HRM Reagent Kit to optimize your
reactions, see “Optimizing the reaction conditions” on page 129.

1. Prepare the negative control reactions in an appropriately sized, labeled tube:

384-well Fast reaction
plate or 96-well Fast

96-well standard reaction

reaction plate plate
TR e el e aveetol
20-uL rep:ltlzjastes 50-uL rep:ltlzjastes
reaction 10% excess reaction 10% excess
MeltDoctor™ HRM Master Mix 10.0 L 33.00 pL 25.0 L 82.5 uL
Primer 1 (5 uM) 1.2 L 3.96 pL 3.0uL 9.9 uL
Primer 2 (5 uM) 1.2 uL 3.96 pL 3.0 uL 9.9 uL
Deionized water 7.6 uL 25.08 pL 19.0 uL 62.7 pL
Total reaction volume 20.0 L 66.00 pL 50.0 uL 165.0 uL

IMPORTANT! Include excess volume in your calculations to provide excess
volume for the loss that occurs during reagent transfers. Applied Biosystems
recommends an excess volume of at least 10%.

2. Prepare positive control reactions and unknown reactions in separate appropriately

sized, labeled tubes:

384-well Fast reaction
plate or 96-well Fast

96-well standard reaction

reaction plate plate
Components Volume Volume for Volume Volume for
three 20-pL three 50-pL
for one . for one .
20-pL replicates 50-pL replicates
reaction plus 10% reaction plus 10%
excess excess
MeltDoctor™ HRM Master Mix 10.0 uL 33.00 pL 25.0 yL 82.5 pL
Primer 1 (5 pM) 1.2 uL 3.96 pL 3.0 uL 9.9 uL
Primer 2 (5 pM) 1.2 yL 3.96 pL 3.0 L 9.9 uL
Genomic DNA (20 ng/uL) 1.0 yL 3.30 pL 2.5 L 8.25 L
Deionized water 6.6 uL 21.78 uL 16.5 uL 54.45
Total reaction volume 20 yL 66 pL 50 uL 165 uL

IMPORTANT! Include excess volume in your calculations to provide excess
volume for the loss that occurs during reagent transfers. Applied Biosystems
recommends an excess volume of at least 10%.
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Prepare the HRM reactions

3. Vortex the reactions to mix, then spin the tubes briefly.

4. Prepare a reaction plate appropriate for your instrument:

a. Pipet each reaction replicate to the appropriate wells of the optical reaction

plate:
. Reaction
Reaction plate volume
Fast 384-well plate 20 yL
Fast 96-well plate 20 pL
Standard 96-well plate 50 yL

b. Seal the reaction plate with optical adhesive film, then spin the reaction plate.

c. Confirm that the liquid is at the bottom of the wells in the reaction plate.

Note: If you plan to wait more than 24 hours before running the plate, store the
plate at 4 °C. Allow the plate to warm to room temperature, then spin the plate
briefly before running it.
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Amplify and melt the DNA

After you have prepared the reaction plate, run the plate to amplify and melt the DNA
and to generate HRM fluorescence data. This chapter contains brief instructions. For

detailed instructions, see:

Chapter 4 Perform an HRM Mutation Scanning Experiment

Amplify and melt the DNA

* Run a 384-well plate on a 7900HT Fast instrument (page 40)

* Run a 96-well plate on a 7900HT Fast instrument (page 43)

* Run a 96-well plate on a 7500 Fast instrument with 7500 Software v2.0 (page 48)
* Run a 96-well plate on a 7500 Fast instrument with SDS Software v1.4 (page 51)

Create and set up
the HRM run file

Run file setting

7900HT Fast System with
SDS Software v2.3 or later

7500 Fast System with
7500 Software v2.0 or later

7500 Fast Real-Time PCR
System with SDS Software
vi4

Document/
experiment

Detector/target
and plate layout

e Assay: Standard Curve
(AQ)

e Container: 384 Wells Clear
Plate or 96 Wells Clear
Plate

e Template: Blank Template

¢ Reporter: MeltDoctor

® Quencher: Non
Fluorescent

¢ |nstrument: 7500 Fast (96
Wells)

e Experiment type:
Quantitation - Standard
Curve

¢ Reagents: Other, then
select the Include Melt
Curve checkbox

e Ramp speed: Standard (~ 2
hours to complete a run)

¢ Reporter: MeltDoctor

e Quencher: None

e Assay: Standard Curve
(Absolute Quantitation)

e Container: 96-Well Clear
e Template: Blank Document

¢ Reporter: MeltDoctor

® Quencher: Non
Fluorescent

Plate layout

Thermal
profile/run method

e Task for negative control
wells: NTC

e Passive Reference: None

¢ Mode: Standard

e Sample Volume (uL): 20
(384-well or 96-well Fast) or
50 (96-well standard)

e Task for negative control
wells: [ ]

e Passive Reference: None
e Reaction Volume Per Well:
20 uL

e Expert Mode: Select the
checkbox

¢ (Click Select/View Filters,
then select only Filter-1

e Task for negative control
wells: NTC

¢ Passive Reference: (none)

e Sample Volume (uL): 20
¢ Run Mode: Fast 7500

e Expert Mode: Select the
checkbox

¢ C(Click Select/View Filters,
then select only Filter A
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Amplify and melt the DNA

Run the plate Note: If you are performing your experiment on the 7900HT Fast instrument using a
96-well reaction plate, perform the melt curve in a separate run because you need to
spin the plate after you amplify the DNA.

Ramp
Stage Step Temp Time (7;3:)?_”
only)
Holding Enzyme activation 95°C | 10 min 100%
Cycling (40 cycles) Denature 95°C | 15sec 100%
Anneal/extend 60 °C 1 min 100%
Melt curve/dissociation | Denature 95°C | 10sec 100%
Anneal 60 °C 1 min 100%
High resolution melting | 95°C | 15sec 1%
Anneal 60°C @ 15sec 100%

Verify that the 1. Review the Amplification Plot for normal characteristics:

samples amplified .
and review the Fluorescence levels that exceed the threshold between cycles 8 and 35

peaks in the melt * An exponential increase in fluorescence

curve
ILFERGEY

Note: Note which wells are outlierswith C; values that differ from replicates by
more than 2. The outliers may produce erroneous HRM results.

Note: If the Amplification Plot looks abnormal, refer to Chapter 6,
“Troubleshooting HRM Experiments” on page 115 to identify and resolve the
problem.
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Chapter 4 Perform an HRM Mutation Scanning Experiment 4
Amplify and melt the DNA

2. Verify that the Dissociation Curve/Melt Curve shows no unexpected Tm peaks:

If the sequence you amplified contains more than 1 variant or a more complex
mutation, you may see more than 1 Tm peak.

Note: Unexpected peaks may indicate contamination, primer dimers, or non-
specific amplification.

Note: The data appear noisy because more data is collected during a high
resolution melt curve than during a standard melt curve. The extra data are
required for analysis with the High Resolution Melting Software.

Setun | nstrument | Resuts | GC Summary  Dissocition Curve.

samEa
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Review the high-resolution melting data

Review the high-resolution melting data

86

Example HRM
experiments

Create and set up
the HRM
experiment

After you create, run, and analyze the *.eds or *.sds file on the 7900HT Fast or 7500
Fast system, use the Applied Biosystems High Resolution Melting Software (HRM
software) to perform high resolution melting analysis of the data and screen the
samples for mutations.

To view an example of an HRM mutation scanning experiment, use the example files
that are installed with the HRM software:

* 384 Mutation Scanning Example.hrm

*  96well Mutation Scanning Example.hrm

The files are located in X:\Applied Biosystems\HRM\experiments, where X is the drive
where you installed the HRM Software.

For more detailed instructions on how to create and set up an HRM experiment, see
pages 56 through 60.

1. Create an HRM experiment in the HRM Software using the *.eds or *.sds run file
from your 7900HT Fast or 7500 Fast system.

Note: If this is your first time creating an HRM experiment with the HRM
software, select the default HRM calibration file. To change the HRM calibration
file for a selected experiment or for all subsequent HRM experiments, see
“Change the HRM calibration file” on page 131.

IMPORTANT! Use the HRM calibration file name to make sure that the HRM
calibration file that is assigned to the HRM experiment is correct. The HRM
calibration file must be:

* Run on the same instrument system (the same instrument, the same block type,
and the same software version) as the run file

* Run using the same HRM dye and master mix used in the HRM calibration
plate

The HRM Software cannot distinguish between all calibration files. For example,
it cannot distinguish between two different 7500 v2.0 instruments or between a
7900HT instrument with the Fast 96-well block and a 7900HT instrument with a
standard 96-well block.
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Review the high-resolution melting data

2. In the Derivative Melt Curves plot, review and adjust the pre- and post-melt
regions to optimize your separation and variant calls. For most experiments, set
the pre- and post-melt regions as close as possible to the melting transition region:

* The pre-melt Start and Stop temperature lines (green and red arrows on the
left) should be approximately 0.2 to 0.5 °C apart from each other.

8&8329

4T3

5.0 57.5 &0.0 62.5 65.0 675 70.0 725 0 775 800 & B5.0 875

Set the pre-melt Stop next to the
start of the melting transition

Set the pre-melt Start ~0.2 to0 0.5 °C
from the pre-melt Stop

» The post-melt Start and Stop temperature lines (green and red arrows on the
right) should be approximately 0.2 to 0.5 °C apart from each other.

8&'529

T4M.T3

Set the post-melt Start next to the end
of the melting transition

Set the post-melt Stop ~0.2 to 0.5 °C from
the post-melt Start
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Review the high-resolution melting data

3. For each control sample, enter information about that control in the HRM
Software and assign the control to the appropriate wells.

The example experiment file, 384 Mutation Scanning Example.hrm, contains the
following controls:

Control Mame el Color
ild Type Al - -
ild Type [etc) - -
ild Type Azl w -
ild Type Ell w v

Note: For control names, do not use the convention variantN, where N is any
number (for example, variantl, variant2, and so on). The HRM Software uses the
convention variantN when automatically assigning the variant calls.

About the melting  The melting profile of a PCR product depends on its GC content, length, sequence, and
profiles  heterozygosity. High-resolution melting analysis calls variants based on the differences
in the shape of the melt curves and the differences in the Tm values.

In mutation scanning experiments, the variants have a different curve shape or Tm
compared to the wild type.

Review the  The Aligned Melt Curves plot displays the melt curves as % melt (0 - 100%) over
populations in the  temperature. The melt curves are aligned to the same fluorescence level using the pre-

Aligned Melt . :
Curves plot and post-melt regions that you set (see page 86).

1. In the Analyzed Data pane, select the Aligned Melt Curves tab.

2. Review:

» Wild type controls — Do the melt curves for the wild type controls cluster
well? Are there any outliers?

* Possible mutations — Are there any samples with melt curves that are
different from the wild type melt curves?

Aligned Melt  In the example below, there is 1 distinct variant group for the wild type samples. There
Curves example  are 2 samples that vary from the wild type samples and may contain mutations.
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Review the high-resolution melting data

Review the The Difference Plot displays the aligned data as the difference in fluorescence between
Difference Plot for  the melt curve for a reference sample and the other melt curves. You can select a
outliers .01 or any well as a reference. After you select the reference, the software subtracts
the reference curve from the other curves.

The Difference Plot allows you to more easily see small differences between curves
and identify outliers.

1. Inthe Analyzed Data pane, select the Aligned Data - Difference Plot tab.

2. From the Reference dropdown menu, select a control or any well as the reference,
then review:

* Variant clusters — How many distinct clusters are displayed?
* OQutliers — How tight are the curves within each variant cluster?

Note: Try selecting different reference samples to find the optimal display of the
clusters.

Difference Plot  In the example below, there is 1 distinct variant group for the wild type samples. There
example  are 2 samples that vary from the wild type samples and may contain mutations.

15
14
13
12
11
10

bhoanwsa
a \

5

B

Review the  The High Resolution Melting Software automatically makes a call for each sample
software calls  according to the shape of the aligned melt curves and the Tm. Review the software
calls, then omit outliers or change calls.

1. In the Results pane, click the Well column header to sort the results according to
the well position.

2. For each replicate group, review:
* Variant Call column — Do all replicates have the same call?

» Confidence column — Are there any outliers within the replicate group? Do
the values for the replicate group differ greatly from the confidence values
for other replicate groups in the plate?

3. To view the fluorescence data for certain wells, select the rows in the Results

table.
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Review the high-resolution melting data

4. In the Results pane, click the Variant Call column header to sort the results
according to the variant call. Scan the results for samples that were not assigned
the same call as the wild type control.

Omit outliers or  After you review the software calls, you can omit outliers or change calls. Remember
change calls {9 click to reanalyze the data after you omit outliers or change calls.

For more detailed instructions, see pages 63 and 64:
*  Omit outliers from analysis
* Change calls made by the software

» Revert selected manual calls to the software Auto call
» Revert all manual calls to the software Auto call
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Sequence the variants

Sequence the variants

After you identify the variants in the HRM software, dilute or purify the PCR product
from the HRM reactions, then sequence the variants.

Dilute the PCR 1. After the PCR amplification, spin the HRM reaction plate at 100 x g for 1 minute.
product

2. Perform DNA quantitation of the PCR products for the selected variants, then
dilute to 0.5-1.5 ng/ulL with water.

3. Use the dilution ratio to determine whether you need to purify the PCR product
before performing the sequencing reactions:

How much did you dilute Next ste
the PCR product? P
<1:20 Purify the PCR product using ExoSAP-IT® (next
procedure) before performing the sequencing
reactions.
>1:20 Perform the sequencing reactions using the diluted
DNA (page 92).

Purify the PCR  If you diluted the PCR product less than 1:20, purify the PCR product using
product  ExoSAP-IT®.

1. Combine the diluted PCR product and ExoSAP-IT in a clean MicroAmp® Fast

Optical Reaction Plate:
Component Volume
Diluted PCR product 10 pL
ExoSAP-IT® 2uL
Total reaction volume 12 pL

2. Mix the reactions well by pipetting up and down with a multichannel pipettor, then
seal the plate with MicroAmp® Clear Adhesive Film.

3. Spin the plate at 1600 x g for 30 seconds.

4. Load the plate in the thermal cycler, cover the plate with an MicroAmp® Optical
Film Compression Pad, then run the reactions in a thermal cycler:

* Reaction volume: 12 uL
» Thermal profile:

Stage Temp Time

1 37°C | 30 min
2 80°C 15 min
3 4°C oo
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Sequence the variants

5. After the run is complete, spin the plate at 100 x g for 1 minute.

Perform the  Perform fast cycle sequencing with modifications to the protocol for the BigDye®
sequencing  Terminator v1.1 Cycle Sequencing Kit. If your PCR products contain an M13 tail from
reactions o primers you used in the HRM amplification reactions, use the M13F and M13R

primers for the forward and reverse primers.

1. Onice, prepare 8 pL of Sequencing Master Mix for each sample:

Component Volume
BigDye® Terminator v1.1 2 uL
Forward primer or reverse primer 1L
Deionized water 4 uL
BigDye® Terminator v1.1, v3.1 5X Sequencing 1L
Buffer
Total volume per reaction 8 puL

Note: Include 5-10% excess volume in the master mix to compensate for
pipetting error.
2. Transfer 8 uL of Sequencing Master Mix to wells of a 96-well reaction plate.

3. Add 2 uL of diluted DNA to the appropriate wells of the reaction plate, then pipet
up and down to mix.

4. Seal the plate with MicroAmp® Clear Adhesive Film, then spin briefly.

5. Run the reactions in a Veriti' 96-Well Fast Thermal Cycler:
* Reaction volume: 10 uL
* Thermal profile:

Stage Step Temp Time
Holding Denaturation 96 °C 1 min
Cycle sequencing (25 Denaturation 96 °C | 10sec
cycles) Annealing 50 °C 3 sec
Extension 60°C | 75sec

Holding Holding 4°C oo

Note: Use a rapid thermal ramp (1 °C/second) for each new temperature.

6. After the run is complete, spin the plate briefly.
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Chapter 4 Perform an HRM Mutation Scanning Experiment
Sequence the variants

Use the BigDye XTerminator® Purification Kit to remove unincorporated BigDye®
terminators. For more instructions on the purification or on transferring the plate to the
DNA Analyzer, refer to the BigDye XTerminator® Purification Kit Protocol

(PN 4374408).

Run the sequencing
reaction products

1. Spin the reaction plate briefly, then add BigDye XTerminator reagents:

a. Add 45 uL of SAM™ Solution to each reaction.

b. Vortex the BigDye XTerminator® Solution thoroughly, then use a wide-bore
pipette tip to add 10 puL to each reaction.

2. Seal the plate with MicroAmp® Clear Adhesive Film, then verify that each well is

sealed.

3. Vortex the plate for 30 minutes.

4. Spin the plate at 1000 x g for 2 minutes.

Run the sequencing reaction products on an Applied Biosystems 3500/3500x/ DNA
Analyzer, 3730/3730x/ DNA Analyzer, 3130/3130x/ Genetic Analyzer, or 3100/3100-

Avant Genetic Analyzer. For more instructions, refer to the user guide for your

instrument.

. . Applied Biosystems . . ABI PRISM®
Applied Biosystems 3730/3730x/ DNA Applied Biosystems 3100/3100-Avant
3500/3500x/ DNA - 3130/3130x/ DNA ) .
Item . Analyzers with Data . Genetic Analyzer with
Analyzer with 3500 Data Collection Software Analyzer with Data Data Collection
Collection Software v1.0 vi.1, v2.0, or v3.0 Collection Software v2.0 Software v2.0
Polymer POP-7™ polymer POP-7™ polymer POP-6™ polymer POP-6™ polymer
Array 50 cm 36 cm 36 cm 36 cm
Run file RapidSeq_BDX_50_POP7 BDX_RapidSeq36_POP7 BDX_RapidSeq36_POP6 BDX_RapidSeq36_POP6
Mobility file = Kb_3500_POP6_BDVA1 KB_3730_POP7_BDTv1. Kb_3130_POP6_BDV1. Kb_3100_POP6_BDV1.
mob mob mob
Basecaller | KB KB KB KB
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Chapter 5

Perform an HRM Methylation Study

Perform an HRM methylation study to determine the percentage of methylated DNA in
unknown samples.

Perform an HRM Methylation Study
Design the HRM experiment (below)
Optimize the HRMieactions (page 97)
Prepare the HRM reactions (page 97)
Amplify and melt the DNA (page 101)

Review the high-resolution melting data (page 105)

Sequence the variants (page 110)

Design the HRM experiment

Design and order  Using Applied Biosystems Methyl Primer Express® Software, design the primers to
the primers  amplify the genomic DNA that spans the methylation sites of interest. With Methyl
Primer Express Software, you can specify the number of CpG dinucleotides to include

in the PCR primers and their position. Order the primers from the Applied Biosystems
Store.
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Design the HRM experiment

1. Design the primers so that they meet these guidelines:

Design attribute Design guidelines

Amplicon e |ength is less than 250 basepairs

¢ To detect high levels of methylation, primers lie
outside of the CpG island

e To detect low levels of methylation, primer
sequences include CpG dinucleotides

Primer length ~20 bases each

Tm 58 °C to 60 °C (Optimal Tm is 59 °C)

% GC content 30-80% GC content in each primer

3’ end No more than 2 G+C residues in the last 5 nucleotides
at the 3’ end

Repeating Avoid consecutive identical nucleotides. If you are

oligonucleotides unable to avoid consecutive identical nucleotides,

make sure that each primer contains fewer than 4
consecutive Gs.

2. Go to www.appliedbiosystems.com, then log into the Applied Biosystems Store
if you have an account; register if you are a new user. For more instructions, see
“Ordering custom primers” on page 128.

Select controls  Including controls for each target sequence in your HRM methylation study:

* At least one negative control
* Methylated DNA standards that contain from 0% to 100% methylated DNA
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Chapter 5 Perform an HRM Methylation Study 5
Optimize the HRM reactions

Optimize the HRM reactions

Optimize the HRM reactions to identify the most suitable PCR reaction to study a
differentially methylated region.

1. Prepare the HRM reactions: Test different reaction conditions.

2. Amplify and melt the DNA: Review the C values to quantify the effficiency of
the PCR reaction.

3. Review the HRM data: Review the specifity of the PCR reaction and the melting
behavior of the PCR fragments.

4. Perform electrophoresis of the PCR products on high-percentage agarose gels:
Verify the size of the amplicon and review the specificity of the PCR reaction.

Prepare the HRM reactions

Combine purified genomic DNA templates with MeltDoctor™ HRM Master Mix and
primers to amplify the target sequence.

Note: Ifyou are using the MeltDoctor” HRM Reagent Kit instead of the MeltDoctor"
HRM Master Mix, see page 129 for reaction component volumes.

Prepare the 1. Obtain universally methylated DNA to represent DNA that is 100% methylated.
methylated DNA

standards 2. Select DNA that is non-methylated to represent DNA that is 0% methylated.

3. Mix different ratios of 100% methylated and 0% methylated DNA of equal
concentration. For example:

DNA Volume to prepare the methylated DNA standard

100% methylated DNA (20 ng/uL) | 10puL 7.5 L 5uL 2.5puL 1L 0L
Non-methylated DNA (20 ng/pL) 0L 2.5puL 5L 7.5puL 9 uL 10 L
% methylated DNA 100% 75% 50% 25% 10% 0%

Note: To detect low levels of methylation, add more standards between 0% and
2% methylation. For example, prepare standards to represent 0.0%, 0.1%, 0.5%,
1%, 2%, 5%, 10%, and 100% methylation.
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Chapter 5 Perform an HRM Methylation Study
Prepare the HRM reactions

Before you perform the HRM reactions for your methylation study, treat your samples
and methylated DNA standards with bisulfite to convert non-methylated cytosines (C)
in your DNA to uracil (U). Samples that vary in the number of U residues within the
amplified sequence will have distinct melt curve shapes and Tm values.

Applied Biosystems recommends that you use the methylSEQr™ Bisulfite Conversion
Kit. For instructions, refer to the Applied Biosystems methyISEQr ™ Bisulfite
Conversion Kit Protocol (PN 4374710).

* Microcentrifuge tubes

* Optical reaction plate appropriate for your Real-Time PCR instrument

»  MicroAmp™ Optical Adhesive Film

+ MeltDoctor" HRM Master Mix

» For each target sequence:
— Forward and reverse primers (5 uM each)
— DNA samples

* Methylated DNA standards

* Deionized water

* Pipettors and pipette tips

* Vortexer

* Centrifuge

Prepare the reactions for each replicate group separately, then transfer the reactions to a
reaction plate appropriate for your instrument.

For information about using the MeltDoctor” HRM Reagent Kit to optimize your
reactions, see “Optimizing the reaction conditions” on page 129.
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Prepare the HRM reactions

1. Prepare the negative control reactions in an appropriately sized, labeled tube:

384-well Fast reaction
plate or 96-well Fast

96-well standard reaction

reaction plate plate
Gomeonents Volume L Volume oL
20-pL rep;.ilcl:Jastes 50-pL rep‘!.ilcl:Jastes
reaction 10% excess reaction 10% excess
MeltDoctor™ HRM Master Mix 10.0 L 33.00 pL 25.0 L 82.5 uL
Primer 1 (5 M) 1.2 yL 3.96 pL 3.0 L 9.9 uL
Primer 2 (5 uM) 1.2 uL 3.96 pL 3.0 uL 9.9 uL
Deionized water 7.6 uL 25.08 pL 19.0 uL 62.7 pL
Total reaction volume 20.0 L 66.00 pL 50.0 L 165.0 pL

IMPORTANT! Include excess volume in your calculations to provide excess
volume for the loss that occurs during reagent transfers. Applied Biosystems
recommends an excess volume of at least 10%.

2. Prepare methylated DNA standards and unknown reactions in separate
appropriately sized, labeled tubes:

384-well Fast reaction
plate or 96-well Fast

96-well standard reaction

reaction plate plate
Components Volume Volume for Volume Volume for
for one three 20-uL for one three 50-pL
20-pL replicates 50-pL replicates
. plus 10% " plus 10%
reaction reaction
excess excess
MeltDoctor™ HRM Master Mix 10.0 L 33.00 pL 25.0 yL 82.5 uL
Primer 1 (5 M) 1.2 L 3.96 pL 3.0 uL 9.9 uL
Primer 2 (5 pM) 1.2 yL 3.96 pL 3.0 L 9.9 uL
Genomic DNA (20 ng/uL) 1.0 yL 3.30 pL 2.5 L 8.25 L
Deionized water 6.6 uL 21.78 uL 16.5 uL 54.45
Total reaction volume 20 yL 66 pL 50 uL 165 uL

IMPORTANT! Include excess volume in your calculations to provide excess
volume for the loss that occurs during reagent transfers. Applied Biosystems
recommends an excess volume of at least 10%.

3. Vortex the reactions to mix, then spin the tubes briefly.
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5 Chapter 5 Perform an HRM Methylation Study
Prepare the HRM reactions

4. Prepare a reaction plate appropriate for your instrument:

a. Pipet each reaction replicate to the appropriate wells of the optical reaction

plate:
. Reaction
Reaction plate volume
Fast 384-well plate 20 yL
Fast 96-well plate 20 pL
Standard 96-well plate 50 L

b. Seal the reaction plate with optical adhesive film, then spin the reaction plate.

c. Confirm that the liquid is at the bottom of the wells in the reaction plate.

Note: If you plan to wait more than 24 hours before running the plate, store the
plate at 4 °C. Allow the plate to warm to room temperature, then spin the plate
briefly before running it.
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Amplify and melt the DNA

After you have prepared the reaction plate, run the plate to amplify and melt the DNA
and to generate HRM fluorescence data. This chapter contains brief instructions. For

detailed instructions, see:

Chapter 5 Perform an HRM Methylation Study
Amplify and melt the DNA

* Run a 384-well plate on a 7900HT Fast instrument (page 40)

* Run a 96-well plate on a 7900HT Fast instrument (page 43)

* Run a 96-well plate on a 7500 Fast instrument with 7500 Software v2.0 (page 48)
* Run a 96-well plate on a 7500 Fast instrument with SDS Software v1.4 (page 51)

Create and set up
the HRM run file

Run file setting

7900HT Fast System with
SDS Software v2.3 or later

7500 Fast System with

7500 Software v2.0 or later

7500 Fast Real-Time PCR
System with SDS Software

vi4

Document/
experiment

Detector/target
and plate layout

Assay: Standard Curve
(AQ)

Container: 384 Wells Clear
Plate or 96 Wells Clear
Plate

Template: Blank Template

Reporter: MeltDoctor

Quencher: Non
Fluorescent

Instrument: 7500 Fast (96
Wells)

Experiment type:
Quantitation - Standard
Curve

Reagents: Other, then
select the Include Melt
Curve checkbox

Ramp speed: Standard (~ 2
hours to complete a run)
Reporter: MeltDoctor
Quencher: None

e Assay: Standard Curve

(Absolute Quantitation)
Container: 96-Well Clear
Template: Blank Document

Reporter: MeltDoctor

Quencher: Non
Fluorescent

Plate layout

Thermal
profile/run method

Task for negative control
wells: NTC

Passive Reference: None

Mode: Standard

Sample Volume (uL): 20
(384-well or 96-well Fast) or
50 (96-well standard)

Task for negative control
wells: [ ]

Passive Reference: None
Reaction Volume Per Well:
20 uL

Expert Mode: Select the
checkbox

Click Select/View Filters,
then select only Filter-1

Task for negative control
wells: NTC

Passive Reference: (none)

Sample Volume (uL): 20
Run Mode: Fast 7500

Expert Mode: Select the
checkbox

Click Select/View Filters,
then select only Filter A

Applied Biosystems High Resolution Melting Getting Started Guide

101



5 Chapter 5 Perform an HRM Methylation Study
Amplify and melt the DNA

Run the plate Note: If you are performing your experiment on the 7900HT Fast instrument using a
96-well reaction plate, perform the melt curve in a separate run because you need to
spin the plate after you amplify the DNA.

Ramp
Stage Step Temp Time (7;3:)?_”
only)
Holding Enzyme activation 95°C | 10 min 100%
Cycling (40 cycles) Denature 95°C | 15sec 100%
Anneal/extend 60 °C 1 min 100%
Melt curve/dissociation | Denature 95°C | 10sec 100%
Anneal 60 °C 1 min 100%
High resolution melting | 95°C | 15sec 1%
Anneal 60°C @ 15sec 100%

Note: For methylation experiments, adjust the annealing temperature during the
amplification to increase or decrease the extent of the PCR bias.
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Chapter 5 Perform an HRM Methylation Study 5
Amplify and melt the DNA

Verify that the 1. Review the Amplification Plot for normal characteristics:

samples amplified .
and review the Fluorescence levels that exceed the threshold between cycles 8 and 35
peaks in the melt * An exponential increase in fluorescence
curve

Sot | instumert Resuts | ac sunmary |
ILFERGEY

Note: Note which wells are outlierswith C; values that differ from replicates by
more than 2. The outliers may produce erroneous HRM results.

Note: If the Amplification Plot looks abnormal, refer to Chapter 6,
“Troubleshooting HRM Experiments” on page 115 to identify and resolve the

problem.
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Amplify and melt the DNA

2. Verify that the Dissociation Curve/Melt Curve shows no unexpected Tm peaks:

With methylation experiments, you will likely see multiple peaks. The number of
peaks in the melt curve is correlated with the number of methylation sites in the
amplicon.

Note: Unexpected peaks may indicate contamination, primer dimers, or non-
specific amplification.

Note: The data appear noisy because more data is collected during a high
resolution melt curve than during a standard melt curve. The extra data are
required for analysis with the High Resolution Melting Software.

Melt Curve

nnnnnnn

The low methylation example above shows multiple Tm peaks because of the
large differences between the samples with low methylation and the wild type
samples. Notice that there are no large Tm peaks at the lower temperatures.
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Chapter 5 Perform an HRM Methylation Study 5
Review the high-resolution melting data

Review the high-resolution melting data

After you create, run, and analyze the *.eds or *.sds file on the 7900HT Fast or 7500
Fast system, use the Applied Biosystems High Resolution Melting Software (HRM
software) to perform high resolution melting analysis of the data and review the
methylation data.

Example HRM  To view an example of an HRM methylation study, use the example files that are
experiments  installed with the HRM software:

* High% Methylation.hrm
*  Low% Methylation.hrm

The files are located in X:\Applied Biosystems\HRM\experiments, where X is the drive
where you installed the HRM Software.

Create and set up  For more detailed instructions on how to create and set up an HRM experiment, see

the HRM  pages 56 through 60.
experiment

1. Create an HRM experiment in the HRM Software using the *.eds or *.sds run file
from your 7900HT Fast or 7500 Fast system.

Note: If this is your first time creating an HRM experiment with the HRM
software, select the default HRM calibration file. To change the HRM calibration
file for a selected experiment or for all subsequent HRM experiments, see
“Change the HRM calibration file” on page 131.

IMPORTANT! Use the HRM calibration file name to make sure that the HRM
calibration file that is assigned to the HRM experiment is correct. The HRM
calibration file must be:

* Run on the same instrument system (the same instrument, the same block type,
and the same software version) as the run file

* Run using the same HRM dye and master mix used in the HRM calibration
plate

The HRM Software cannot distinguish between all calibration files. For example,
it cannot distinguish between two different 7500 v2.0 instruments or between a
7900HT instrument with the Fast 96-well block and a 7900HT instrument with a
standard 96-well block.
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Review the high-resolution melting data

2. In the Derivative Melt Curves plot, review and adjust the pre- and post-melt
regions to optimize your separation and variant calls. For most experiments, set
the pre- and post-melt regions as close as possible to the melting transition region:

* The pre-melt Start and Stop temperature lines (green and red arrows on the
left) should be approximately 0.2 to 0.5 °C apart from each other.

TIWES DJDEHS

\
>

L\VN

Set the pre-melt Stop next to the
start of the melting transition

Set the pre-melt Start ~0.2 to 0.5 °C
from the pre-melt Stop

* The post-melt Start and Stop temperature lines (green and red arrows on the
right) should be approximately 0.2 to 0.5 °C apart from each other.

TS DJDEDS

%

L\VNN

Set the post-melt Start next to the end
of the melting transition

Set the post-melt Stop ~0.2 to 0.5 °C from
the post-melt Start
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About the melting
profiles

Review the
populations in the
Aligned Melt
Curves plot
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Chapter 5 Perform an HRM Methylation Study 5
Review the high-resolution melting data

3. For each control sample, enter information about that control in the HRM
Software and assign the control to the appropriate wells.

The example experiment file, Low% Methylation.hrm, contains the following
controls:

Control Name el I Color

0% c10 ﬂ‘. -
0.1% c3 ﬂ‘. -
0.5% cs ﬂ‘. -
1% c7 L”. -
e c6 - (Il -
E% s - -
10% 4 - -
100% c3 LI [ | -

Note: For control names, do not use the convention variantN, where N is any
number (for example, variantl, variant2, and so on). The HRM Software uses the
convention variantN when automatically assigning the variant calls.

The melting profile of a PCR product depends on its GC content, length, sequence, and
heterozygosity. High-resolution melting analysis calls variants based on the differences
in the shape of the melt curves and the differences in the Tm values.

In methylation studies, the shape of the melt curve and the Tm values vary according to
the number of C residues converted to U after the bisulfite treatment.

The Aligned Melt Curves plot displays the melt curves as % melt (0 - 100%) over
temperature. The melt curves are aligned to the same fluorescence level using the pre-
and post-melt regions that you set (see page 105).

1. In the Analyzed Data pane, select the Aligned Melt Curves tab.

2. Review:

* Methylated DNA standards — Do the melt curves for the methylated DNA
standards cluster well? Are there any outliers?

* Define methylation range for unknowns — Which methylated standard melt
curves are above and below the melt curves for the unknowns? For example,
if the melt curve for an unknown sample lies between the melt curves for the
5% and 10% methylated standards, the unknown sample contains between
5% and 10% methylated nucleotides.

107



5 Chapter 5 Perform an HRM Methylation Study
Review the high-resolution melting data

Aligned Melt  In the example below, there are 8 distinct variant groups, 1 for each methylation
Curves example  gtandard.

Review the The Difference Plot displays the aligned data as the difference in fluorescence between
Difference Plot for  the melt curve for a reference sample and the other melt curves. You can select a
outliers  ,htrol or any well as a reference. After you select the reference, the software subtracts
the reference curve from the other curves.

The Difference Plot allows you to more easily see small differences between curves
and identify outliers.

1. In the Analyzed Data pane, select the Aligned Data - Difference Plot tab.

2. From the Reference dropdown menu, select a control or any well as the reference,
then review:

* Variant clusters — How many distinct clusters are displayed?
* Outliers — How tight are the curves within each variant cluster?

Note: Try selecting different reference samples to find the optimal display of the
clusters.

Difference Plot In the example below, there are 8 distinct variant groups, 1 for each methylation
example  standard.
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Chapter 5 Perform an HRM Methylation Study 5
Review the high-resolution melting data

Review the The High Resolution Melting Software automatically makes a call for each sample
software calls  according to the shape of the aligned melt curves and the Tm. Review the software
calls, then omit outliers or change calls.

1. In the Results pane, click the Well column header to sort the results according to
the well position.

2. For the methylation standard controls, review:

* Variant Call column — Do all of the methylation standard controls have the
correct call?

» Confidence column — Are there any outliers within the replicate group? Do
the values for the replicate group differ from the confidence values for the
other replicate groups in the plate?

Note: If any of the controls are outliers, omit them from the HRM analysis, then
reanalyze.

3. To view the fluorescence data for certain wells, select the rows in the Results
table.

Omit outliers or  After you review the software calls, you can omit outliers or change calls. Remember
change calls o click to reanalyze the data after you omit outliers or change calls.
For more detailed instructions, see pages 63 and 64:
*  Omit outliers from analysis
» Change calls made by the software
* Revert selected manual calls to the software Auto call
* Revert all manual calls to the software Auto call
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Sequence the variants

Sequence the variants

After you identify the samples that contain methylated C residues in the amplified
region, dilute or purify the PCR product from the HRM reactions, then sequence the
variants. Because the samples were treated with bisulfite before the HRM reactions,
the U residues in the sequencing results correspond to methylated C residues.

Dilute the PCR 1. After the PCR amplification, spin the HRM reaction plate at 100 x g for 1 minute.
product

2. Perform DNA quantitation of the PCR products for the selected variants, then
dilute to 0.5-1.5 ng/uLL with water.

3. Use the dilution ratio to determine whether you need to purify the PCR product
before performing the sequencing reactions:

How much did you dilute
the PCR product? Next step
<1:20 Purify the PCR product using ExoSAP-IT® (next
procedure) before performing the sequencing
reactions.
>1:20 Perform the sequencing reactions using the diluted
DNA (page 111).

Purify the PCR  If you diluted the PCR product less than 1:20, purify the PCR product using
product  ExoSAP-IT®.

1. Combine the diluted PCR product and ExoSAP-IT in a clean MicroAmp® Fast
Optical Reaction Plate:

Component Volume
Diluted PCR product 10 pL
ExoSAP-IT® 2L
Total reaction volume 12 pL

2. Mix the reactions well by pipetting up and down with a multichannel pipettor, then
seal the plate with MicroAmp® Clear Adhesive Film.

3. Spin the plate at 1600 x g for 30 seconds.
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Sequence the variants

4. Load the plate in the thermal cycler, cover the plate with an MicroAmp® Optical
Film Compression Pad, then run the reactions in a thermal cycler:

* Reaction volume: 12 uL.
» Thermal profile:

Stage Temp Time

1 37°C | 30 min
2 80°C | 15min
3 4°C oo

5. After the run is complete, spin the plate at 100 x g for 1 minute.

Perform the  Perform fast cycle sequencing with modifications to the protocol for the BigDye®
sequencing  Terminator v1.1 Cycle Sequencing Kit. If your PCR products contain an M13 tail from
reactions primers you used in the HRM amplification reactions, use the M13F and M13R

primers for the forward and reverse primers.

1. Onice, prepare 8 pL of Sequencing Master Mix for each sample:

Component Volume
BigDye® Terminator v1.1 2L
Forward primer or reverse primer 1L
Deionized water 4 uL
BigDye® Terminator v1.1, v3.1 5X Sequencing 1L
Buffer
Total volume per reaction 8 uL

Note: Include 5-10% excess volume in the master mix to compensate for
pipetting error.

2. Transfer 8 pL of Sequencing Master Mix to wells of a 96-well reaction plate.

3. Add 2 pL of diluted DNA to the appropriate wells of the reaction plate, then pipet
up and down to mix.

4. Seal the plate with MicroAmp® Clear Adhesive Film, then spin briefly.

Applied Biosystems High Resolution Melting Getting Started Guide 111



112

Chapter 5 Perform an HRM Methylation Study

Sequence the variants

Purify the
sequencing
reaction

5. Run the reactions in a Veriti' 96-Well Fast Thermal Cycler:
» Reaction volume: 10 pL
» Thermal profile:

Stage Step Temp Time
Holding Denaturation 96 °C 1 min
Cycle sequencing (25 Denaturation 96 °C | 10sec
cycles) Annealing 50 °C 3 sec
Extension 60°C | 75sec

Holding Holding 4°C )

Note: Use a rapid thermal ramp (1 °C/second) for each new temperature.
6. After the run is complete, spin the plate briefly.

Use the BigDye XTerminator® Purification Kit to remove unincorporated BigDye®
terminators. For more instructions on the purification or on transferring the plate to the
DNA Analyzer, refer to the BigDye XTerminator® Purification Kit Protocol

(PN 4374408).

1. Spin the reaction plate briefly, then add BigDye XTerminator reagents:
a. Add 45 uL of SAM™ Solution to each reaction.

b. Vortex the BigDye XTerminator® Solution thoroughly, then use a wide-bore
pipette tip to add 10 puL to each reaction.

2. Seal the plate with MicroAmp® Clear Adhesive Film, then verify that each well is
sealed.

3. Vortex the plate for 30 minutes.

4. Spin the plate at 1000 x g for 2 minutes.
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Run the sequencing
reaction products

Chapter 5 Perform an HRM Methylation Study

Sequence the variants

Run the sequencing reaction products on an Applied Biosystems 3500/3500x/ DNA
Analyzer, 3730/3730x/ DNA Analyzer, 3130/3130x/ Genetic Analyzer, or 3100/3100-

Avant Genetic Analyzer. For more instructions, refer to the user guide for your

instrument.

. . . . ABI PRISM®
Applied Biosystems Applied Biosystems 3100/3100-Avant
Item 3500/3500x/ DNA 3130/3130x/ DNA Genetic Analyzer with
Analyzer with 3500 Data Analyzer with Data yze
- ? Data Collection
Collection Software v1.0 = Collection Software v2.0
Software v2.0
Polymer POP-6™ polymer POP-4™ polymer POP-4™ polymer
Array 50 cm 36 cm 36 cm
Run file StsSeq_BDX_50_POP6 BDX_RapidSeq36_POP4 BDX_RapidSeq36_POP4
Mobility file = Kb_3500_POP6_BDVA1 Kb_3130_POP4_BDV1. Kb_3100_POP4_BDV1.
mob mob
Basecaller KB KB KB

Applied Biosystems High Resolution Melting Getting Started Guide
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Sequence the variants
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Chapter 6

Troubleshooting HRM Experiments

Problems with HRM experiments are usually evidenced by abnormal amplification
plots or by abnormal HRM curves.

Observation Page

Abnormal amplification plots

Late amplification: C; value >30 for a majority of samples 116
Some late amplification: C; value >30 for some samples 116
PCR inhibition: Ampilification curve with low slope and Cy values higher than expected 117
Nonspecific amplification: Decreased PCR efficiency and multiple amplicons 118
Abnormal HRM curves

Replicates are widely spread: Sample replicates show a wide spread in HRM curves 119
Multiple melt regions: Complex melt curves with multiple melting regions 119
More than three different variant calls (HRM genotyping experiments only) 120
Messy HRM curves: Diagonal wavy curves below heterozygous clusters 120

For more guidance on troubleshooting, refer to:
* Applied Biosystems Real-Time PCR Troubleshooting Tool:
www.appliedbiosystems.com/troubleshoot

» Applied Biosystems Guide to High Resolution Melting (HRM) Analysis (Stock
number O-081740-0509)
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Late ampilification: Ct value >30 for a majority of samples

Late amplification: C; value >30 for a majority of samples

The amplification reaction may not reach the plateau phase. HRM resolution may be
affected by the lower increase in fluorescence.

Possible causes

Recommended action

Poor DNA quality.
Amount of DNA added to the HRM reactions is too low.

Re-extract the DNA.

Perform PCR optimization, and increase sample input or
increase the number of amplification cycles.

Some late amplification: C; value >30 for some samples

Sample outliers with C; values that are greater than those for the replicates also have a
Tm shift in the HRM curve. The resulting Tm shift may affect the variant call.

Possible causes

Recommended action

Reaction volume for the outlier is visibly greater than or
less than the reaction volume for the replicates.

Repeat the HRM reactions, and make sure that you add
the correct volumes to each well. Also, after you seal the
plate, spin the plate briefly.

Amount of DNA added to the HRM reactions is too low.

PCR inhibition.

Repeat the HRM reactions with more DNA in each
reaction.

If the amplification curve also has a low slope and all
replicates for a sample are affected, see page 117 to
troubleshoot PCR inhibition in your HRM reactions.
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Chapter 6 Troubleshooting HRM Experiments
PCR inhibition: Amplification curve with low slope and C values higher than expected

PCR inhibition: Amplification curve with low slope and C;

values higher than expected

The amplification curve has a low slope and the amplification reaction may not reach
the plateau phase. HRM resolution may be affected by the lower increase in

fluorescence.
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Cycle Number

Possible causes

Recommended action

DNA sample contains contaminants that inhibit PCR.

Incorrect salt concentration.

Dilute the samples 1:10 or 1:100, then repeat the HRM
reactions.

Perform a MgCl, titration to find the optimal salt
concentration for each reaction.

Reaction does not contain sufficient enzyme.

Reaction does not contain sufficient primer.

Amplicon is greater than 200 bp.

Primers are amplifying multiple targets.

Optimize the reaction using the MeltDoctor™ HRM
Reagent Kit (see page 129 for reaction component
volumes). You can add up to 0.15 U/uL AmpliTaq Gold®
360 DNA Polymerase to each reaction.

Optimize the reaction using the MeltDoctor™ HRM
Reagent Kit (see page 129 for reaction component
volumes). You can add up to 0.5 pM of each primer to each
reaction.

Increase the extension timeS during the amplification
reaction.

Perform a BLAST search to ensure primer specificity. If the
primers are not specific, design new primers.

Reduce the number of amplification cycles.
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Nonspecific amplification: Decreased PCR efficiency and multiple amplicons

Nonspecific amplification: Decreased PCR efficiency and
multiple amplicons

Decreased PCR efficiency and multiple amplicons may affect the melting behavior of
the true target amplicons.

Possible causes Recommended action

Incorrect salt concentration. Perform a MgCl, titration to find the optimal salt
concentration for each reaction.

Primers are amplifying multiple targets. Perform a BLAST search to ensure primer specificity. If the
primers are not specific, design new primers.

Reduce the number of amplification cycles.

After PCR amplification, consider running some of the PCR
product on a gel to make sure that it contains a single
band.
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Replicates are widely spread: Sample replicates show a wide spread in HRM curves

Replicates are widely spread: Sample replicates show a wide
spread in HRM curves

A wide spread within a population leads to difficulties in assessing true sequence
differences, particularly between two different homozygous populations.

Possible causes Recommended action

Population spread Use multiple controls for HRM analysis to help you define
the population spread.

Incorrect salt concentration. Perform a MgCl, titration to find the optimal salt
concentration for each reaction.

DNA starting concentrations vary widely between samples. = Make sure that the starting DNA concentrations are similar
for the samples that you are testing.

Low PCR efficiencies. Ensure efficient PCR.

Multiple melt regions: Complex melt curves with multiple
melting regions

Complex melt curves are difficult to interpret. If the amplicon is too long, the melt
curve may have multiple melt regions because of the regional sequence context of the

amplicon.
Possible causes Recommended action
The amplicon contains more than one SNP (genotyping Sequence the PCR product to confirm whether the
experiments only). amplicon contains more than 1 SNP. If the sequencing
reveals more SNPs, redesign the primers so that the
amplicon contains only 1 SNP.
The amplicon is too long. Redesign the primers to reduce the amplicon size.
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More than three different variant calls (HRM genotyping experiments only)

More than three different variant calls (HRM genotyping

experiments only)

If the target contains unknown SNPs, multiple heterozygous and homozygous
amplicons can be produced. If the amplicon is too long, the melt curve may have
multiple melt regions even without a SNP because of the regional sequence context of

the amplicon.

Possible causes

Recommended action

The amplicon contains more than 1 SNP.

Sequence the PCR product to confirm whether the
amplicon contains more than 1 SNP. If the sequencing
reveals more SNPs, redesign the primers so that the
amplicon contains only 1 SNP.

The amplicon is too long.

Redesign the primers to reduce the amplicon size.

Messy HRM curves: Diagonal wavy curves below heterozygous

clusters

HRM data from negative controls and unamplified samples skew the pre- and post-
melt curve settings and interfere with the variant calls.

Possible cause

Recommended action

Negative controls and unamplified samples are included in
the HRM analysis.

Omit negative controls and unamplified samples from the
HRM analysis. Refer to the Applied Biosystems High
Resolution Melting Software Help.
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Appendix A

Ordering Information

Materials and equipment for HRM calibration and HRM
experiments

MeltDoctor™ HRM

reagents ltem App.!,igﬂ I:i?r:fetf "
MeltDoctor™ HRM Calibration Plate, Fast 96-Well 4425618
MeltDoctor™ HRM Calibration Plate, 384-Well 4425559
MeltDoctor™ HRM Calibration Standard (20X), 1 mL 4425562
MeltDoctor™ HRM Master Mix, 5 mL bottle 4415440
MeltDoctor™ HRM Master Mix, 5 x 5 mL bottle 4415452
MeltDoctor™ HRM Master Mix, 10 x 5 mL bottle 4415450
MeltDoctor™ HRM Master Mix, 50 mL bottle 4409535
MeltDoctor™ HRM Positive Control Kit: 4410126

e MeltDoctor™ HRM Allele A DNA (20X), 150 pL

e MeltDoctor™ HRM Allele G DNA (20X), 150 pL

e MeltDoctor™ HRM Allele A/G DNA (20X), 150 pL
¢ MeltDoctor™ HRM Primer Mix (20X), 500 pL
MeltDoctor™ HRM Reagent Kit: 4425557
e AmpliTag Gold® 360 DNA Polymerase
* AmpliTaq Gold® 360 Buffer

e 360 GC Enhancer

e GeneAmp® dNTP Blend

e MeltDoctor™ HRM Dye (20X)

Equipment and

software
Item Source
Applied Biosystems 7500 Fast Real-Time PCR System with Applied Biosystems
Notebook Computer (PN 4351106)
Applied Biosystems 7500 Fast Real-Time PCR System with Applied Biosystems
Tower Computer (PN 4351107)
Applied Biosystems 7900HT Fast Real-Time PCR System with Applied Biosystems
384-Well Block Module (PN 4329001)
Applied Biosystems 7900HT Fast Real-Time PCR System with Applied Biosystems
384-Well Block Module and Automation Accessory (PN 4329002)
Applied Biosystems 7900HT Fast Real-Time PCR System with Applied Biosystems
Fast 96-Well Block Module (PN 4351405)
Applied Biosystems 7900HT Fast Real-Time PCR System with Applied Biosystems
Standard 96-Well Block Module (PN 4329003)
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Materials and equipment for HRM calibration and HRM experiments

Item Source
Applied Biosystems High Resolution Melting Software Applied Biosystems
(PN 4397808)
Primer Express® Software v3.0 or later Applied Biosystems
Centrifuge with plate adapters Major laboratory
suppliers (MLS)
Lab equipment MLS
Microcentrifuge MLS
Microcentrifuge tubes MLS
Pipettors and pipette tips MLS
Vortexer MLS
Supplies
Item Source

Appropriate reaction plate for your instrument: Applied Biosystems
e MicroAmp™ Optical 384-Well Reaction Plate with Barcode, e PN 4346906 and

0.1 mL 4366932
¢ MicroAmp™ Fast Optical 96-Well Reaction Plate with e PN 4309849 and

Barcode, 0.1 mL 4343814
¢ MicroAmp™ Optical 96-Well Reaction Plate with Barcode, e PN 4306737

0.2 mL
MicroAmp® Optical Adhesive Film: Applied Biosystems
e 25 covers e PN 4360954
e 100 covers e PN 4311971
Microcentrifuge tubes MLS
Pipettors and pipette tips MLS
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Materials and equipment for sequencing variants after HRM analysis

Materials and equipment for sequencing variants after HRM

analysis

Equipment

Supplies

Reagents

Item

Source

Applied Biosystems DNA sequencer:

¢ Applied Biosystems 3500/3500x/ DNA Analyzer
e Applied Biosystems 3730/3730x/ DNA Analyzer
e Applied Biosystems 3130/3130x/ DNA Analyzer
e Applied Biosystems 3100/3100-Avant DNA Analyzer

Applied Biosystems

Veriti™ 96-Well Fast Thermal Cycler

Applied Biosystems

Centrifuge with plate adapters MLS
Microcentrifuge MLS
Vortexer MLS

Item

Source

MicroAmp® Clear Adhesive Film, 100 films

MicroAmp® Optical Film Compression Pad

Applied Biosystems
PN 4306311

Applied Biosystems

Wide-bore (>1 mm) pipette tips:
e Wide-Orifice Tips
e Clear Wide Bore Tips

Microcentrifuge tubes

e Rainin Instrument LLC
¢ Axygen Scientific Inc.

MLS

Pipettors and pipette tips

MLS

Item

Source

BigDye® Terminator v1.1 Cycle Sequencing Kit, 100 reactions

BigDye XTerminator® Purification Kit, 2 mL (~100 20-pL
reactions)

Applied Biosystems
(PN 4337450)

Applied Biosystems
(PN 4376486)

M13 forward and reverse sequencing primers:
e M13 Forward (-20), 2 ug
e M13 Reverse, 2 ug

Note: Use only if the HRM PCR product contains the M13
sequences.

UltraPure™ DNase/RNase-Free Distilled Water, 500 mL

Invitrogen¥

* PN N520-02
* PN N530-02

Invitrogen PN 10977-015

ExoSAP-IT®, 100 reactions

Deionized Water

USB Corporation*
PN 78200

MLS

T Forthe MSDS of any chemical not distributed by Applied Biosystems, contact the chemical manufacturer.
Before handling any chemicals, refer to the MSDS provided by the manufacturer, and observe all relevant

precautions.
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Materials and equipment for sequencing variants after HRM analysis
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Appendix B

Supplemental Information and
Procedures

This appendix contains supplemental information and procedures for preparing and
running HRM reactions and for using the High Resolution Melting Software (HRM

Software).
B About HRM dAyes . ... e 126
B Usingother HRMdyes........... ... ... .. 126
B Prepare an HRM calibrationplate .................................. 127
B Prepare the DNA templates . ..............c i, 128
B Ordering CuStOM PIiMETS . .. oottt ettt ettt e e e e e 128
B Optimizing the reaction conditions. . ............. ... ..., 129
B Computer FeqUITCIMENTS. . . o\ v vttt et et et e et et e e e e 130
B Change the HRM calibrationfile .. ................................. 131
B If you are running multiple HRM assays . ............................ 133
B Publishingthedata ......... ... ... ... . . . 133
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About HRM dyes

About HRM dyes

The melting profile of a PCR product is best obtained with high-resolution melting
dyes (HRM dyes). HRM dyes are double-stranded DNA(dsDNA )-binding dyes that
have high fluorescence when bound to dsDNA and low fluorescence in the unbound
state. HRM analysis uses dsDNA-binding dyes that are brighter than those previously
used, and they do not inhibit PCR at high-dye concentrations. With traditional dyes (for
example, SYBR® Green I dye), only limited concentrations of the dye can be used
before the dye inhibits the PCR (Kent ef al., 2007).

Using other HRM dyes

126

This getting started guide describes procedures for calibrating your instrument and
performing HRM experiments using the MeltDoctor’” HRM Dye.

If you choose to use a different HRM dye, calibrate your instrument for that dye.
Follow the procedures provided, but substitute the MeltDoctor"” HRM Dye with your
HRM dye and prepare your own calibration plate.

You should also optimize your reactions for the HRM dye that you choose, because
each dye interacts uniquely with all other reaction components, affecting the sensitivity
of the analysis.
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Prepare an HRM calibration plate

This procedure is for preparing your own HRM calibration plate using the
MeltDoctor™ HRM Master Mix and MeltDoctor” HRM Calibration Standard.

IMPORTANT! The HRM calibration plate should be prepared fresh and used
immediately. It is important to perform the amplification run, custom dye calibration,
and HRM calibration on the same day that the HRM calibration plate is prepared.

Note: Ifyou are using the MeltDoctor” HRM Reagent Kit instead of the MeltDoctor"
HRM Master Mix, use the same component volumes in the HRM calibration plate that
you are using in your HRM reactions.

1. Add the required volumes of each component to an appropriately sized tube:
Volume (pL)
Component 384-well plate Fast 96-well plate Standard 96-well plate
. 425 . 110 . 110
1 reaction N 1 reaction . 1 reaction .
reactions reactions reactions
MeltDoctor™ HRM Master Mix 10 4250 10 1100 25.0 2750
MeltDoctor™ HRM Calibration 1 425 1 110 25 275
Standard (20X)
Deionized water 9 3825 9 990 22.5 2475
Total volume 20 8500 20 2200 50 5500

5. Inspect the plate to make sure all wells contain liquid.

Cap the tube, then vortex to mix.

Spin the tube briefly.

Pipet the HRM calibration reactions to each well of an appropriate reaction plate

for your instrument:

Reaction plate

Reaction
volume

Fast 384-well plate
Fast 96-well plate

Standard 96-well plate

20 L
20 L
50 pL

IMPORTANT! Accurate pipetting is required for proper calibration.

IMPORTANT! Empty wells may cause the calibration to fail.

6. Seal the reaction plate with optical adhesive film, then spin the reaction plate.

Applied Biosystems High Resolution Melting Getting Started Guide

127



Appendix B Supplemental Information and Procedures
Prepare the DNA templates

Prepare the DNA templates

1. Purify all the DNA samples in an HRM experiment using the same method. Watch
out for salt carryover because it will subtly change the thermodynamics of the
DNA melting transition.

2. Perform agarose gel electrophoresis and spectrophotometry to make sure the DNA
template is intact and is not contaminated with other DNAs, RNAs, proteins, or
organic chemicals. Proteins and organic chemicals may inhibit the PCR
amplification, and contaminating DNAs and RNAs may result in sub-optimal
PCR performance or increased change of non-specific amplification.

3. Determine the quantity of DNA using spectrophotometry. If too little DNA
template is added to the reaction, the fluorescence signal may not be sufficient for
successful HRM analysis. If too much DNA template is added to the reaction, the
PCR may be inhibited.

4. (Optional) Dilute the DNA to 20 ng/uL.

Ordering custom primers

1. Go to www.appliedbiosystems.com, then log into the Applied Biosystems Store
if you have an account; register if you are a new user.

2. Below the Custom Primers & Probes heading, click Custom Unlabeled Primers,
then click Sequence Detection Primers.

3. In the Ordering Information tab, select the check box next to the quantity of
primers to order, then click Configure.

4. Follow the instructions on the web page to configure the primers:
a. Select purification and formulation options.
b. Enter or upload the primer names and sequences.

c. Review the oligos to order.

Note: If any of the oligos are invalid, follow the instructions on the web page
to edit the sequence information.

5. Click Add to Basket.

6. Follow the link to your Shopping Basket, then follow the instructions on the web
page to place your order.
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Optimizing the reaction conditions
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Optimizing the reaction conditions

If you want to optimize the reaction conditions, use the MeltDoctor'” HRM Reagent
Kit. See Table 1 for the recommended reaction component volumes.

For more information on optimizing your HRM reactions, refer to A Guide to High
Resolution Melting (HRM) Analysis (Stock number O-081740 0509).

Table 1 Recommended reaction component volumes using the
MeltDoctor™ HRM Reagent Kit

Volume for Final concentration
Components one Zq-pL range
reaction

AmpliTag Gold® 360 Buffer, 10X 2pL 1X
25 mM Magnesium Chloride 1.21t01.8 uL 1.5t03.5mM
GeneAmp® dNTP Blend, 10 mM 0.2t0 0.6 pL 100 to 300 pM each
Primer 1 (5 pM) 0.8t02.0uL 0.2t0 0.5 yM
Primer 2 (5 pM) 0.81t02.0 L 0.2 t0 0.5 uM
MeltDoctor™ HRM Dye (20X) 1.0 uL 1X
AmpliTag Gold® 360 DNA 0.2t0 0.6 pL 0.05 to 0.15 U/pL
Polymerase (5 U/pL)
Human gDNA (20 ng/pL) 1L 10 pg/pL to 10 ng/pL
Deionized water As needed =
Total volume 20 uL

Applied Biosystems High Resolution Melting Getting Started Guide 129



Appendix B Supplemental Information and Procedures
Computer requirements

Computer requirements

The hardware and software requirements for running version 2.0 of the HRM software

are listed in the table below.

Component Recommended Requirements Minimum Requirements#
Computer Intel® Pentium® 4 processor or compatible ¢ Intel® Pentium® 4 processor or compatible
processor, 2.0 GHz processor, 1.2 GHz
1 GB of RAM e 1GB of RAM
One hard drive$ with 10 GB available ® One hard drive with 10 GB available
20/48X IDE CD-ROM e 20/48X IDE CD-ROM
USB v2.0 e USBv1.1
Ethernet network interface adapter (10BASE-T) | e Ethernet network interface adapter (10BASE-T)
UL listed e UL listed
CE marked e CE marked
FCC labeled e FCC labeled
Monitor 1280 x 1024 pixel resolution for full screen e 1280 x 1024 pixel resolution for full screen
display display
16-inch color monitor e 16-inch color monitor
32-bit color e 32-bit color
UL listed e UL listed
Operating Microsoft® Windows® XP Operating System, Microsoft® Windows® XP Operating System,
System Service Pack 1 or greater Service Pack 1 or greater
¢ Microsoft® Windows® Vista® Operating System

¥ The Minimum Requirements column lists the lowest specifications that permit the installer to install the software. The minimum requirements
may not provide optimal performance. Applied Biosystems does not guarantee support of an installation in this environment.
§ For optimal performance of the software, partition the hard drives on your computer.
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Change the HRM calibration file

Change the HRM calibration file

Use the Change Calibration File function to:

* Change (overwrite) the HRM calibration file for a selected HRM experiment

* Change the default HRM calibration file for all subsequent new HRM
experiments

Change (overwrite) This option changes (overwrites) the HRM calibration file for the selected HRM
the HRM calibration experiment'

file
1. In the HRM Experiments pane, select the HRM experiment to edit.

2. Open the Open Calibration File dialog box:
¢ Inthe toolbar, click ‘ ..d Change Calibration File

or

* In the menu bar, select File » Change Calibration File.

3. Browse to and select the appropriate HRM calibration file (*.eds or *.sds file),
then click OK.

IMPORTANT! The HRM calibration file must be:
* Run on the same instrument as the run file

* Run in the same reaction plate type as the run file (384-well, 96-well Fast, or
96-well standard)

* Run with the same software version as the run file

Note: If you cannot see the Browse button, resize the dialog box.

Open Calibration File ) +—P lf needed, click and
Please select a valid calibration file for the E/L drag the bOFdeI’S tO
ssperiment 4 resize the dialog

I‘ Browse bOX.

Cancel

Applied Biosystems High Resolution Melting Getting Started Guide 131



Appendix B Supplemental Information and Procedures
Change the HRM calibration file

Change the default
HRM calibration file

132

This option changes the default HRM calibration file for all subsequent new HRM
experiments.

1. From the menu bar, select Analysis » Change Default Calibration File to open
the Open Calibration File dialog box.

Analysis | Layout Plots Help

Analysis Settings
Analyze
Change Default Calibration File

2. From the Instrument Type dropdown menu, select the appropriate instrument.

3. Browse to and select the appropriate HRM calibration file (*.eds or *.sds file),
then click OK.

IMPORTANT! The HRM calibration file must be:
* Run on the same instrument as the run file

* Run in the same reaction plate type as the run file (384-well, 96-well Fast, or
96-well standard)

* Run with the same software version as the run file

Note: If you cannot see the Browse button, resize the dialog box.

Open Calibration File . +—P If needed, click and
Please select a valid calibration file for the ‘C—/L drag the bOI’deI’S tO
Speriment 4 resize the dialog

I‘ Browse bOX.

Cancel
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If you are running multiple HRM assays

In the HRM Software, an assay is defined as a specific combination of Detector/Target
and Dye. You can have multiple assays in the same plate, and the HRM Software
analyzes each assay separately, using distinct analysis settings.

If your reaction plate contains multiple HRM assays, make sure that you select the
assay from the Assay dropdown menu before you review the results or make any
changes to the HRM experiment file.

Publishing the data

You can publish the data from the HRM Software in several ways:
» Copy and paste data from the Results Pane to a text or spreadsheet application (for
example, Microsoft® Word Software or Microsoft® Excel Software).
* Create slides
* Export data
* Print a plot
* Print a report
* Save a plot as an image file
)

For information on performing these procedures, click 2 or press F1 in the software

to access the software Help.
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Software Warranty Information

Computer Configuration

Applied Biosystems supplies or recommends certain configurations of computer
hardware, software, and peripherals for use with its instrumentation.

Applied Biosystems reserves the right to decline support for or impose extra charges
for supporting nonstandard computer configurations or components that have not been
supplied or recommended by Applied Biosystems. Applied Biosystems also reserves
the right to require that computer hardware and software be restored to the standard
configuration prior to providing service or technical support. For systems that have
built-in computers or processing units, installing unauthorized hardware or software
may void the Warranty or Service Plan.

Limited Product Warranty

Limited Warranty

Warranty Period
Effective Date

Applied Biosystems High Resolution Melting Getting Started Guide

Applied Biosystems warrants that for a period of ninety (90) days from the date the
warranty period begins, its High Resolution Melting Software will perform
substantially in accordance with the functions and features described in its
accompanying documentation when properly installed on the instrument system for
which it is designated, and that for a period of ninety (90) days from the date the
warranty period begins, the tapes, diskettes, or other media bearing the software
product will be free of defects in materials and workmanship under normal use. If
buyer believes that it has discovered a failure of the software to satisfy the foregoing
warranty, and if buyer notifies Applied Biosystems of such failure in writing during the
ninety (90) day warranty period, and if Applied Biosystems is able to reliably
reproduce such failure, then Applied Biosystems, at its sole option, will either (i)
provide any software corrections or “bug-fixes” of the identified failure, if and when
they become commercially available, to buyer free of charge, or (ii) notify buyer that
Applied Biosystems will accept a return of the software from the buyer and, upon such
return and removal of the software from buyer's systems, terminate the license to use
the software and refund the buyer's purchase price for the software. If there is a defect
in the media covered by the above warranty and the media is returned to

Applied Biosystems within the ninety (90) day warranty period, Applied Biosystems
will replace the defective media. Applied Biosystems does not warrant that the
software will meet buyer's requirements or conform exactly to its documentation, or
that operation of the software will be uninterrupted or error free.

Any applicable warranty period under these sections begins on the earlier of the date of
installation or ninety (90) days from the date of shipment for software installed by
Applied Biosystems personnel. For all software installed by the buyer or anyone other
than Applied Biosystems, the applicable warranty period begins the date the software
is delivered to the buyer.
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Warranty Claims

Warranty
Exceptions

Warranty
Limitations

Appendix C Software Warranty Information
Limited Product Warranty

Warranty claims must be made within the applicable warranty period.

The above warranties do not apply to defects resulting from misuse, neglect, or
accident, including without limitation: operation outside of the environmental or use
specifications, or not in conformance with the instructions for the instrument system,
software, or accessories; improper or inadequate maintenance by the user; installation
of software or interfacing, or use in combination with software or products, not
supplied or authorized by Applied Biosystems; and modification or repair of the
product not authorized by Applied Biosystems.

The foregoing provisions set forth Applied Biosystems' sole and exclusive
representations, warranties, and obligations with respect to its products, and

Applied Biosystems makes no other warranty of any kind whatsoever, expressed or
implied, including without limitation, warranties of merchantability and fitness for a
particular purpose, whether arising from a statute or otherwise in law or from a course
of dealing or usage of trade, all of which are expressly disclaimed.

The remedies provided herein are the buyer's sole and exclusive remedies. Without
limiting the generality of the foregoing, in no event shall Applied Biosystems be liable,
whether in contract, tort, warranty, or under any statute (including without limitation
any trade practice, unfair competition, or other statute of similar import) or on any
other basis, for direct, indirect, punitive, incidental, multiple, consequential, or special
damages sustained by the buyer or any other person or entity, whether or not
foreseeable and whether or not Applied Biosystems is advised of the possibility of such
damages, including without limitation, damages arising from or related to loss of use,
loss of data, failure or interruption in the operation of any equipment or software, delay
in repair or replacement, or for loss of revenue or profits, loss of good will, loss of
business, or other financial loss or personal injury or property damage.

No agent, employee, or representative of Applied Biosystems has any authority to
modify the terms of this Limited Warranty Statement or to bind Applied Biosystems to
any affirmation, representation, or warranty concerning the product that is not
contained in this Limited Warranty Statement, and any such modification, affirmation,
representation, or warranty made by any agent, employee, or representative of
Applied Biosystems will not be binding on Applied Biosystems unless in a writing
signed by an executive officer of Applied Biosystems.

This warranty is limited to the buyer of the product from Applied Biosystems and is
not transferable.

Some countries or jurisdictions limit the scope of or preclude limitations or exclusion
of warranties, of liability, such as liability for gross negligence or willful misconduct,
or of remedies or damages, as or to the extent set forth above. In such countries and
jurisdictions, the limitation or exclusion of warranties, liability, remedies or damages
set forth above shall apply to the fullest extent permitted by law, and shall not apply to
the extent prohibited by law.
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Safety

This appendix covers:

B General chemicalsafety . .......... .. ... .. .. i 138
B MDD S ottt 139
B Biological hazard safety . ............ ... ... ... i 140
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General chemical safety

138

Chemical hazard WARNING! CHEMICAL HAZARD. Before handling any chemicals, refer to

warning

the Material Safety Data Sheet (MSDS) provided by the manufacturer, and
observe all relevant precautions.

Chemical safety To minimize the hazards of chemicals:

guidelines

Read and understand the Material Safety Data Sheets (MSDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals or
hazardous materials. (See “About MSDSs” on page 139.)

Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the MSDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the MSDS.

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended in the MSDS.

Comply with all local, state/provincial, or national laws and regulations related to
chemical storage, handling, and disposal.
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MSDSs
MSDSs

About MSDSs  Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with
shipments of hazardous chemicals to new customers. They also provide MSDSs with
the first shipment of a hazardous chemical to a customer after an MSDS has been
updated. MSDSs provide the safety information you need to store, handle, transport,
and dispose of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to
replace the appropriate MSDS in your files.

Obtaining The MSDS for any chemical supplied by Applied Biosystems is available to you free
MSDSs 24 hours a day. To obtain MSDSs:

1. Go to www.appliedbiosystems.com, click Support, then select MSDS.

2. In the Keyword Search field, enter the chemical name, product name, MSDS part
number, or other information that appears in the MSDS of interest. Select the
language of your choice, then click Search.

3. Find the document of interest, right-click the document title, then select any of the
following:

*  Open — To view the document
* Print Target — To print the document

» Save Target As — To download a PDF version of the document to a
destination that you choose

Note: For the MSDSs of chemicals not distributed by Applied Biosystems, contact the
chemical manufacturer.
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Biological hazard safety

Biological hazard safety

General biohazard @ WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,
infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Follow all applicable local, state/provincial, and/or
national regulations. Wear appropriate protective equipment, which includes but
is not limited to: protective eyewear, face shield, clothing/lab coat, and gloves.
All work should be conducted in properly equipped facilities using the
appropriate safety equipment (for example, physical containment devices).
Individuals should be trained according to applicable regulatory and
company/institution requirements before working with potentially infectious
materials. Read and follow the applicable guidelines and/or regulatory
requirements in the following:

+ U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories (stock no. 017-
040-00547-4; bmbl.od.nih.gov)

*  Occupational Safety and Health Standards, Bloodborne Pathogens (29
CFR§1910.1030; www.access.gpo.gov/
nara/cfr/waisidx_01/29¢fr1910a_01.html).

*  Your company’s/institution’s Biosafety Program protocols for working
with/handling potentially infectious materials.

Additional information about biohazard guidelines is available at:
www.cdc.gov
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Documentation and Support

Related documentation

HRM  The following documents about HRM experiments are available from
documentation  Applied Biosystems:

»  Applied Biosystems High Resolution Melting Software Help (PN 4393101) —
Installed with and accessible from within the HRM Software, the Help system
describes the software and provides procedures for common tasks.

* Quick reference cards provide abbreviated procedures for performing HRM
experiments using MeltDoctor” HRM Reagents and HRM Software:

— Perform an HRM Genotyping Experiment Quick Reference Card
(PN 4421675)

— Perform an HRM Mutation Scanning Experiment Quick Reference Card
(PN 4426174)

— Perform an HRM Methylation Study Quick Reference Card (PN 4426173)
* A Guide to High Resolution Melting (HRM) Analysis (Stock number O-081740) —

This document provides background information on HRM analysis to help you
perform robust HRM experiments.

Access the HRM  To access the Applied Biosystems High Resolution Melting Sofiware Help system from
Help system  yithin the HRM software, click € in the software window, select Help » HRM Help,
or press F1.

7500 Fast and  The following related documents are available from Applied Biosystems:
7900HT Fast
System

. Instrument and Part
documentation software Document number
7900HT Fast System and | Applied Biosystems 7900HT Fast Real-Time PCR 4365542
SDS Software v2.3 or System Maintenance and Troubleshooting Guide
later Sequence Detection Systems Software Online NA¥

Help for the Applied Biosystems 7900HT Fast
Real-Time PCR System

7500 Fast System and Applied Biosystems 7500/7500 Fast Real-Time 4387777

7500 Software v2.0 or PCR System Maintenance Guide

later Applied Biosystems 7500 Software v2.0 Help NA
Applied Biosystems 7300/7500/7500 Fast Real- 4347828

7500 Fast System and gz;gce}ePCR System Installation and Maintenance

SDS Software v1.4

Applied Biosystems 7300/7500/7500 Fast Real- NA
Time PCR System Online Help

I The instrument Help systems can be accessed from within the instrument software.
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How to obtain support

How to obtain support

For the latest services and support information for all locations, go to:
www.appliedbiosystems.com

At the Applied Biosystems web site, you can:
* Access worldwide telephone and fax numbers to contact Applied Biosystems
Technical Support and Sales facilities.
* Search through frequently asked questions (FAQs).
* Submit a question directly to Technical Support.

* Order Applied Biosystems user documents, MSDSs, certificates of analysis, and
other related documents.

* Download PDF documents.
* Obtain information about customer training.
* Download software updates and patches.
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